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Preface FIX ME!

This preface includes the following sections:

• What’s New in This Release

• About This Guide

• Customer Support

The installation instructions in this guide reflect the latest version of
Synopsys software for each product. Not all products are the same
version.

Important:
Install each version of the software in a new directory. Do not
install different versions of Synopsys software in the same
directory.
xv



What’s New in This Release

This guide has been divided into two parts: Part 1 contains
synthesis, test, and verification tools and Part 2 contains placement
and routing tools.

The following verification and test tools have been added to this
guide:

• VCS, VCSi

• Vera

• VHDL Simulation (Scirocco)

The following placement and routing tools have been added to this
guide:

• Astro, Columbia, and JupiterXT

• HSPICE

• Star-RCXT

• TCAD

For information about new features and changes in specific
Synopsys tools, see the individual product documentation. For links
to Synopsys documentation, see “Related Publications” in the next
section.
xvi
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About This Guide

The Installation Guide provides the basic information and
procedures required to install Synopsys tools.

Audience

This guide is written for system administrators responsible for
installing Synopsys software tools.

Related Publications

For additional information about Synopsys tools, see

• Synopsys Online Documentation (SOLD), which is included with
the software for CD users or is available to download through the
Synopsys Electronic Software Transfer (EST) system

• Documentation on the Web, which is available through SolvNet
at http://solvnet.synopsys.com

• The Synopsys MediaDocs Shop, from which you can order
printed copies of Synopsys documents, at
http://mediadocs.synopsys.com
xvii
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Conventions

The following conventions are used in Synopsys documentation.

Convention Description

Courier Indicates command syntax.

Courier italic Indicates a user-defined value in Synopsys
syntax, such as object_name. (A user-defined
value that is not Synopsys syntax, such as a
user-defined value in a Verilog or VHDL
statement, is indicated by regular text font
italic.)

Courier bold Indicates user input—text you type verbatim—
in Synopsys syntax and examples. (User input
that is not Synopsys syntax, such as a user
name or password you enter in a GUI, is
indicated by regular text font bold.)

[ ] Denotes optional parameters, such as
pin1 [pin2 ... pinN]

| Indicates a choice among alternatives, such as
low | medium | high
(This example indicates that you can enter one
of three possible values for an option:
low, medium, or high.)

_ Connects terms that are read as a single term
by the system, such as
set_annotated_delay

Control-c Indicates a keyboard combination, such as
holding down the Control key and pressing c.

\ Indicates a continuation of a command line.

/ Indicates levels of directory structure.

Edit > Copy Indicates a path to a menu command, such as
opening the Edit menu and choosing Copy.
xviii
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Customer Support

Customer support is available through SolvNet online customer
support and through contacting the Synopsys Technical Support
Center.

Accessing SolvNet

SolvNet includes an electronic knowledge base of technical articles
and answers to frequently asked questions about Synopsys tools.
SolvNet also gives you access to a wide range of Synopsys online
services including software downloads, documentation on the Web,
and “Enter a Call to the Support Center.”

To access SolvNet,

1. Go to the SolvNet Web page at http://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not
have a Synopsys user name and password, follow the
instructions to register with SolvNet.)

If you need help using SolvNet, click SolvNet Help in the Support
Resources section.
xix

Customer Support



Contacting the Synopsys Technical Support Center

If you have problems, questions, or suggestions, you can contact the
Synopsys Technical Support Center in the following ways:

• Open a call to your local support center from the Web by going to
http://solvnet.synopsys.com (Synopsys user name and
password required), then clicking “Enter a Call to the Support
Center.”

• Send an e-mail message to support_center@synopsys.com.

• Telephone your local support center.

- Call (800) 245-8005 from within the continental United States.

- Call (650) 584-4200 from Canada.

- Find other local support center telephone numbers at
http://www.synopsys.com/support/support_ctr.
xx
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Part I: Synthesis, Test, and Verification
Tools





1
Preparing for Installation 1

This chapter provides information about steps to complete before
you install Synopsys tools.

The chapter contains the following sections:

• Checking Your Hardware and Software Configuration

• Acquiring a License

• Finding Your Site Identification Number

• Creating the Synopsys Root Directory

• Defining the SYNOPSYS Environment Variable
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Checking Your Hardware and Software Configuration

You must check your hardware and software configuration (including
patch requirements) before you attempt to load any Synopsys tools.

Supported Platforms and Operating Systems

Table 1-1 lists the supported platforms, operating systems, and
corresponding Synopsys platform keywords for this release. Many
platforms require operating system (OS) patches, including year
2002 patches. For detailed information, see the Qualified Runtime
System Configuration page on the Synopsys Web site. Go to

http://www.synopsys.com/products/sw_platform.html

and click Qualified Runtime System Configuration.

This Web page provides information about supported hardware,
operating systems, and required OS patches. If the required patch
described in the Qualified Runtime System Configuration is not
available from the platform vendor, install the most recent patch
instead.

Table 1-1 Supported Platforms, Operating Systems, and Keywords

Platform Operating system Synopsys platform keywords Windows
environment

HP HP-UX 11.0, 11i hp32 (32-bit mode)
hp64 (64-bit mode)

CDE

Sun Solaris 8, 9 sparcOS5 (32-bit mode)
sparc64 (64-bit mode)

CDE
1-2
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HP-UX Requirements

The HP-UX operating system has the following requirements:

• Local (non-NFS) file systems must be configured for long file
names.

See the /etc/convertfs man page for details.

• The chown privilege must be switched off.

To switch off chown, enter

% setprivgrp -n chown

See the setprivgrp man page for details.

Red Hat Linux 7.2 Shared Object File Problem

 If you receive an error about libncurses.so.4 (cannot open shared
object file: no such file or directory) when you run a Synopsys tool on
a Red Hat 7.2 platform, install the ncurses4 package. This package
is available on the Red Hat CD, or you can download it from the Red
Hat FTP server at

IBM AIX 4.3.3 rs60001 CDE

Intel IA-32 Red Hat Linux 7.2 linux (32-bit mode) GNOME

1. The RS/6000 platform is not available on CD. It will be available for download by EST at a later date. For
availability, check with your Synopsys sales representative.

Table 1-1 Supported Platforms, Operating Systems, and Keywords

Platform Operating system Synopsys platform keywords Windows
environment
1-3

Checking Your Hardware and Software Configuration



ftp://ftp.redhat.com/pub/redhat/linux/7.2/en/os/i386/RedHat/RPMS/
ncurses4-5.0-4.i386.rpm

64-Bit Mode on HP-UX and Solaris Platforms

The Synopsys tools now support 64-bit operation on HP-UX and
Solaris platforms. When you run the tools in 64-bit mode, the upper
limit for virtual address space is extended beyond the 4-gigabyte limit
imposed by the 32-bit mode, allowing you to process larger designs.
With both the 32-bit and 64-bit platforms installed, you have the
flexibility to run either 32-bit or 64-bit applications without running out
of memory.

You can install the 64-bit version of the Synopsys tools in the same
root directory as the 32-bit version or in a separate directory. When
both 32-bit and 64-bit dc_shell executable files are installed and you
specify dc_shell, the first executable file in the PATH environment is
invoked.

Note:
If you attempt to use the 64-bit mode on a 32-bit platform, you will
see an error message.

Multiple-Platform Installation

When you install files on a network that connects different platforms,
the result is the directory tree shown in Figure 1-1.
1-4
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Figure 1-1 Illustration of a Multiple-Platform Installation

Each Synopsys product includes a platform-independent package
(indicated by the shaded box in Figure 1-1) containing files common
to all platforms. When you select multiple platforms, the installation
script installs one platform-independent package and a
platform-dependent package for each selected platform.

If you have previously installed a product on one platform and want
to install it on another platform,

1. Rerun the installation script for the product.

2. In the installation script,

- Answer n to the query about installing the
platform-independent package.

- Specify the new platform when queried about which platform
to install.

$SYNOPSYS

admin auxx doc dw interfaces libraries packages platform1

Platform-independent

platform2
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Products and Platforms

Table 1-2 lists the products and their supported platforms. For the
latest product-specific platform information, see the release notes for
your tool.

Table 1-2 Products and Supported Platforms

Product Product ID Platform keyword

AMPS amps sparcOS5, hp32

Arcadia arc sparcOS5, sparc64, hp32,
hp64, rs6000

CoCentric Fixed-Point Designer fxd sparcOS5, hp32, linux

CoCentric System Studio css sparcOS5, hp32, linux
gccsparcOS5

Floorplan Compiler fpc sparcOS5, sparc64, hp32, hp64

Formality fm sparcOS5, sparc64, hp32,
hp64, rs6000, linux

FPGA Compiler II fc2 sparcOS5, hp32, Windows

NanoSim (including ADFMI,
    NanoSim Integration with
    VCS, turboWave, Verilog-A,
    and VTRAN)

ns sparcOS5, sparc64, hp32,
hp64, rs6000, linux

PathMill pm sparcOS5, sparc64, hp32,
hp64, linux, rs6000

PowerArc pa sparcOS5, hp32

PowerMill (including ADFMI,
    VTRAN, and turboWave)

pw sparcOS5, sparc64, hp32,
hp64, rs6000

PrimePower pp/pps sparcOS5, hp32, linux

PrimeTime pt/pts sparcOS5, sparc64, hp32,
hp64, linux
1-6
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Note:
Products that support the RS/6000 platform will be available by
EST at a later date. For more information, contact your local
applications consultant.

RailMill rm sparcOS5, sparc64, hp32,
hp64, rs6000

Synthesis syn1 sparcOS5, sparc64, hp32,
hp64, rs6000, linux

TetraMAX tx/txs sparcOS5, sparc64, hp32,
hp64, linux, gccsparcOS5

TimeMill (including ADFMI,
    VTRAN, and turboWave)

tm sparcOS5, sparc64, hp32,
hp64, rs6000

VCS vcs, vcsi sparcOS5, sparc64,
hp11.0 PA2.0_32, 64, linux, AIX
32, dec_alpha_osfl_4.0_64

Vera vera sparcOS5, sparc64, hp32, linux,
rs6000

VHDL Simulation (Scirocco) scirocco sparcOS5, hpux10, linux,
rs6000

1. For individual synthesis tool platforms, see the product-specific release notes.

Table 1-2 Products and Supported Platforms (Continued)

Product Product ID Platform keyword
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Disk Space Requirements

Table 1-3 lists the amount of disk space required to install the various
Synopsys tools. Each CD also includes this information in the
top-level README.product_name file.

Table 1-3 Disk Space Requirements

Synopsys product Required size in MB (approximate)

AMPS
Platform independent
Per platform

35
110

Arcadia
Platform independent
Per platform

3
400

CoCentric Fixed-Point Designer
Platform independent
Per platform

1
20

CoCentric System Studio
Platform independent
Per platform

700
600

CoCentric System Studio SOLD 100

Floorplan Compiler
Platform independent
Per platform

50
400

Formality
Platform independent
Per platform

102
132

FPGA Compiler II
Platform independent
Per platform

150
100

NanoSim
Platform independent
Per platform

50
500
1-8
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PathMill
Platform independent
Per platform

11
172

PowerArc
Platform independent
Per platform

50
300

PowerMill
Platform independent
Per platform
sparcOS5

50
300
450

PrimePower
Platform independent
Per platform

492
122

PrimeTime
Platform independent
Per platform

300
350

RailMill
Platform independent
Per platform

3
250

Synthesis tools
Platform independent
Per platform

400
1160

Synopsys online documentation
(English)

385

Synopsys online documentation
(Japanese)

350

TetraMAX (overlay)
Platform independent
Per platform

9
40

Table 1-3 Disk Space Requirements (Continued)

Synopsys product Required size in MB (approximate)
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Memory Requirements

The UNIX kernel defines hard per-process limits on the maximum
amount of memory that can be used, and the limit command
creates soft limits. If ignored, these limits can cause processes (jobs)
to fail even when sufficient memory is available. For more
information, see “Memory” on page 25-2.

TetraMAX (stand-alone)
Platform independent
Per platform

9
112

TimeMill
Platform independent
Per platform
sparcOS5

50
300
450

VCS
Per platform 400

Vera
Per platform 400

VHDL Simulation (Scirocco)
Platform independent
Per platform

320
150

Table 1-3 Disk Space Requirements (Continued)

Synopsys product Required size in MB (approximate)
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Table 1-4 lists the general guidelines for the minimum amount of
physical memory and swap space (virtual memory) required to run
Synopsys tools.

Table 1-4 Minimum Memory Requirements

Tool Physical memory (MB) Swap space (MB)

AMPS 256
Recommended: 1G

512
Recommended: 2G

Arcadia 256 512

CoCentric Fixed-Point Designer 64 140

CoCentric System Studio 256 512

Floorplan Compiler 256 512

Formality1 256 512

FPGA Compiler II 64 140

NanoSim 256
Recommended: 1G

512
Recommended: 2G

PathMill 256
Recommended: 1G

512
Recommended: 2G

PowerArc 150 256

PowerMill 256
Recommended: 1G

512
Recommended: 2G

PrimePower 128 256

PrimeTime 150 256

RailMill 256 512

Synthesis tools 128 256

TetraMAX2 256 512
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Physical Memory Requirements for Synthesis,
PrimeTime, and Design Budgeting

To run the synthesis, PrimeTime, or design budgeting tools
efficiently, the physical memory must equal 25 to 50 percent of the
swap space. For example, if you have 128 MB of swap space, you
need at least 32 MB of physical memory. You might need as much as
64 MB, however. The more physical memory you have, the more
quickly your job runs.

Swap Space Requirements for Synthesis Tools

The amount of swap space required by the synthesis tools depends
on the size and type of each circuit design.

Use the following formula to help you determine the minimum
amount of available swap space required for HDL designs:
16.3 MB + (5.9 x (size of the design in K gates)).

TimeMill 256
Recommended: 1G

512
Recommended: 2G

VCS 256
Recommended: 2 G

768

Vera 256
Recommended: 1G

512
Recommended: 2G

VHDL Simulation (Scirocco) 256
Recommended: 1G

512
Recommended: 2G

1. For large designs, the expected amount of required memory is approximately 1 million bytes
per 2,000 gates.
2. Physical memory and swap space requirements are dependent on design size. The above
figures assume that design size is less than 1 million (equivalent NAND) gates.

Table 1-4 Minimum Memory Requirements (Continued)

Tool Physical memory (MB) Swap space (MB)
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For example, a 5K-gate design requires 16.3 + (5.9 x 5) = 45.8 MB
of available swap space.

Accessing Memory Beyond 2 GB With 32-Bit
Synopsys Tools

In general, UNIX-based systems support a maximum memory of 2
GB for 32-bit processes. However, the following Synopsys tools can
extend memory beyond 2 GB:

• Behavioral Compiler

• Design Compiler

• DFT Compiler

• Floorplan Compiler

• Floorplan Manager

• Formality

• HDL Compiler (Presto Verilog)

• NanoSim

• Physical Compiler

• Power Compiler

• PowerArc

• PowerMill

• PrimePower

• PrimeTime

• RailMill
1-13
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• RailMill

• Scirocco

• TimeMill

• VCS

• Vera

• VHDL Compiler

Note:

Available memory is space not used by the OS, the windowing
system, or other applications.

To access memory beyond 2 GB,

1. Do one of the following, depending on the platform you are using:

- For HP-UX,

Make sure your server has HP-UX 11.0 (or later) loaded.

- For Solaris,

Make sure your server has Solaris 8 (or later) loaded.

2. Make sure your server has at least 4 GB of memory (physical and
swap space) available.

Note:

Physical memory equals data size plus stack size, and stack
size is used before data size. Therefore setting stack size to a
large value causes problems for designs that need to go over
2 GB. If you set the stack size too high, you cannot get enough
memory for your data. To check the settings, use the limit
command at the system prompt. For more information, see
“Memory” on page 25-2.
1-14
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3. Make sure the system you are using does not have restrictions
that prevent you from using more than 2 GB of memory.

4. Create unlimited data size in the shell that you are using: C,
Bourne, Korn or Bash. If there are systemwide limits on the data
size you can create, you can remove them or override them. You
can do this in one of two ways:

- Enter one of the following commands:

For the C shell,

% limit datasize 3800000

For the Bourne, Korn, or Bash shell,

# ulimit -S -d 3800000

- Modify the kernel of your server. This approach allows
everyone using your server to extend memory beyond 2 GB.

Note:

On HP-UX systems, you will see a data size of 2 GB. This
value is accurate. After your process reaches the 2-GB limit,
the Synopsys product extends the address space.
1-15
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Acquiring a License

The Synopsys Common Licensing (SCL) system provides a single,
common licensing base for all Synopsys tools. The SCL software
and the documentation describing how to install and configure it are
separate from the tools that use it.

Before you can use the Synopsys tools, you must do the following:

• If you have not already done so, retrieve your license keys from
the SmartKeys Web page.

• Install the SCL software.

Note:

Installation of Synopsys tools and SCL is not order dependent.
You can install SCL before or after you install your Synopsys
tools. However, you cannot use your Synopsys tools until you
have installed, configured, and started SCL.

Obtaining Your License Keys

To obtain your license key file from SmartKeys,

1. Go to the SmartKeys Web page at

http://www.synopsys.com/smartkeys

2. On the SmartKeys Web page, click Key Retrieval.

3. In the Key Retrieval box, enter the following information:
1-16
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- Your site ID. This is the numeric site ID that identifies your
customer site. If you have synthesis, test, or VHDL simulation
tools installed, you can obtain the site ID by viewing your
site_info file: $SYNOPSYS/admin/license/site_info.

- Your host ID (optional). To obtain a license key file for a single
host, enter its host ID. To obtain license keys for all hosts at the
specified site, leave this field blank.

- Your e-mail address. The default is your Synopsys e-mail
address. This is the address that your key file will be sent to.

4. Click Continue to submit your request.

Installing Synopsys Common Licensing Software

You need to install, configure, and start a single copy of SCL
software for all Synopsys tools. If you don’t have the SCL software,
you can download it by EST or FTP: See the
http://www.synopsys.com/keys/#download_SCL Web page.

Alternatively you can order the SCL software CD from the Synopsys
MediaDocs Shop at http://mediadocs.synopsys.com.

If you already have SCL running, you do not need to reinstall it.
However, if you are updating your license key file, you need to notify
the SCL daemons that the license file has changed. See the SCL
documentation for instructions on this process.

Note:
Do not install SCL into an existing directory. You must install SCL
into a stand-alone directory.

For more information about licensing, see the following documents:
1-17
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• Licensing Quick Start

• Licensing Installation and Administration Guide

Soft copies of the Licensing Quick Start document and the Licensing
Installation and Administration Guide are available in Portable
Document Format (PDF) from http://www.synopsys.com/keys/
#Info_SCL.

Finding Your Site Identification Number

Before you install any Synopsys product CD, locate and make a note
of your Synopsys site identification number. Enter your site ID when
prompted during the installation process.

Your site ID was shipped in the package with your Synopsys tools, or
if you download the software, it is in your Synopsys Order
Notification e-mail. If you have trouble locating it, contact your
Synopsys sales representative.

Creating the Synopsys Root Directory

To create a new directory tree for this Synopsys release, enter

% mkdir -p /usr/synopsys/productversion

To set the permissions on the new directory tree, enter

% chmod 755 /usr/synopsys/productversion
1-18
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Important:
Install each version of the software in a new directory. Do not
install different versions of Synopsys software in the same
directory.

Defining the SYNOPSYS Environment Variable

Set the SYNOPSYS environment variable ($SYNOPSYS) in the shell
that you are using: C, Bourne, Korn, or Bash. In the following
examples, the root_directory argument is the name of the
Synopsys root directory.

If you are using the C shell, enter the following command to set the
SYNOPSYS environment variable:

% setenv SYNOPSYS root_directory

If you are using the Bourne, Korn, or Bash shell, enter the following
command to set the SYNOPSYS environment variable:

# SYNOPSYS=root_directory; export SYNOPSYS
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2
Downloading and Installing the Software 2

This chapter provides information about downloading and installing
Synopsys tools.

The chapter contains the following sections:

• Downloading and Installing the Software by EST

• Performing EST Installation

• Installing Product Files From a CD

• Installing Tools in the Correct Sequence
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Downloading and Installing the Software by EST

You can download Synopsys software in two ways:

• By FTP

• From the Web

For help with download problems, contact the Synopsys Electronic
Software Transfer department:

E-mail support: est-adm@synopsys.com
Telephone support: 650-584-1631

To access the online EST Troubleshooting Guide, go to
http://www.synopsys.com/cgi-bin/est.cgi.

Caution!
 Install each version of the software in a new directory. Do not
install different versions of Synopsys software in the same
directory.

Using the Product Files

Depending on file size, product files are packaged by one of three
processes, tar, tar.Z, or tar.gz. These instructions cover each
process.

The product files use the following naming convention:

For .tar files

productname_productversion_common.tar
productname_productversion_platform.tar
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For tar.Z files

productname_productversion_common.tar.Z
productname_productversion_platform.tar.Z

For tar.gz files

productname_productversion_common.tar.gz
productname_productversion_platform.tar.gz

For each tool you want to install, substitute the appropriate product
ID and version for productname_productversion and platform
keyword for platform. (See “Products and Platforms” on page 1-6.)

Important:
For each product except SOLD, VHDL Simulation (Scirocco), and
VCS, you must install one common file (platform-independent
package) and one or more platform-specific files. (See Figure 1-1
on page 1-5.) For VHDL Simulation (Scirocco) and VCS, install
the platform file only. For SOLD, install only the tar files. (SOLD
version U-2003.03 does not have a common file and is platform
independent.)

Downloading the Files by FTP

To download the files by FTP,

1. For each tool, you must create a separate empty directory to
download your product files into. For example,

% mkdir /tmp/product
% cd /tmp/product

2. Start an FTP session to ftp.synopsys.com:

% ftp ftp.synopsys.com

3. Enter your SolvNet user name and password.
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4. At the ftp prompt, enter the following commands:

ftp> binary
ftp> cd rev
ftp> cd productname_productversion
ftp> get productname_productversion_common.tar
ftp> get productname_productversion_platform.tar

For a list of supported platforms and products for this release,
see Table 1-2 on page 1-6.

5. Download the files into the directory you just created.

6. For installation instructions, see “Performing EST Installation” on
page 2-5.

Downloading the Files From the Web

To download files from the Web,

1. For each tool, you must create a separate temporary directory to
download your product files into. For example,

% mkdir /tmp/product
% cd /tmp/product

2. Go to the Electronic Software Transfer (EST) Web page at

http://www.synopsys.com/cgi-bin/est.cgi

3. Click the Authenticated Access button.

4. Enter your SolvNet user name and password.

5. Read the legal page and, if you agree, click “Yes, I agree to the
above terms.”

6. Click the rev folder.

7. Click the file folder for the product and version you want to install.
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8. Download the files into the temporary directory.

Note:

For each product, you must download one common file
(platform-independent package) and one or more
platform-specific files.

9. For installation instructions, see “Performing EST Installation,”
next.

Performing EST Installation

To install the software,

1. Untar the .tar files, or untar and uncompress the tar.Z or tar.gz
files. For example,

For tar files

% tar xvf productname_productversion_common.tar
% tar xvf productname_productversion_platform.tar

For tar.Z files

% cat productname_productversion_common.tar.Z | uncompress | tar xvf -
% cat productname_productversion_platform.tar.Z | uncompress | tar xvf -

or

% zcat productname_productversion_common.tar.Z | tar xvf -
% zcat productname__productversion_platform.tar.Z | tar xvf -

For tar.gz files

% gzip -dc productname_productversion_common.tar.gz | tar xvf -
% gzip -dc productname_productversion_platform.tar.gz | tar xvf -
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Substitute the appropriate product ID and version for
productname_productversion and platform keyword for platform.
(See “Products and Platforms” on page 1-6.)

2. Execute the following command to install the software:

% ./install.now

To install Synopsys tools, it is recommended that you log on as
root or have system administrator privileges. You need write
permission for the installation directory.

3. Answer the installation program prompts.

Important:

When you are prompted to choose a location for installing the
software, do not select the temporary files directory. You must
specify a new directory. Do not install different versions of
Synopsys software in the same directory.

Repeat steps 1 through 3 for each tool you want to install.

Installing Product Files From a CD

Use the same installation procedure to transfer the files from each
CD (or CD set) to your system.

To install a CD,

1. Mount the CD.

2. Run the installation script.

3. Unmount the CD.
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Complete information about these steps is given in the following
sections.

Mounting the CD

Mounting the CD might require root access privileges. If you do not
have root access privileges, see your system administrator for
instructions on mounting the CD. If you have the proper privileges,
complete the following steps.

To mount the CD,

1. Place the CD in the CD drive.

2. Create a CD directory. For example, enter

% mkdir /cdrom

3. Mount the CD by using the appropriate command for your
operating system. For example, enter

% mount -o ro /dev/dsk/c2t1d4s0 /cdrom

Note:
Mounting instructions are different for each platform. See your
system documentation for the correct CD mounting commands.

Also, for sparcOS5 with vold (the volume management daemon
for managing CD and floppy devices), the /cdrom directory
already exists and the CD is automatically mounted. Therefore,
use cd /cdrom/cdrom0 instead of cd /cdrom (and use eject to
unmount the CD).
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Installing the Software From the CD

The following steps apply only to tools that use the standard
installation. For CD installation of FPGA Compiler II, see “Installing
the Software” on page 10-3.

To install the software,

1. Move to the CD-ROM directory. For example, enter

% cd /cdrom

2. View the README.1ST file on the CD for more information. View
the README.productname file for the most up-to-date disk
space requirements.

3. Enter the installation command.

% ./install.now

4. Answer the installation program prompts.

If you receive an UNCOMPRESS/TAR ERROR during the
installation script, rerun the installation command, using the
-i option to correct the problem. For example, enter

% ./install.now -i

Example 2-1 shows a sample Synopsys media installation script for
the synthesis tools; it applies to installation by EST and from the CD.
Other tools are installed in a similar manner.
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Note:
To perform an overlay installation for PrimePower or TetraMAX,
when you are prompted to select the product you want to install,
enter pp (for PrimePower) or tx (for TetraMAX). To perform a
stand-alone installation, enter pps (for PrimePower stand-alone)
or txs (for TetraMAX stand-alone).

Example 2-1 Synopsys Media Installation Script for the Synthesis Tools

                   Synopsys Media Installation

Instructions:  The list within {} shows the choices for a given option.
               The entry within [] shows the default selection when you
               hit the Return key.  You can cancel the installation by
               by entering quit when prompted for input.

___________________________________________________________________________

The current mounted Synopsys CD file system is U-2003.03.

        VERSION:      U-2003.03
        PRODUCTS:     syn sf3 sf4 pc
        PLATFORMS:    sparcOS5
        PART NUMBER:  XXXXXX

___________________________________________________________________________

Install U-2003.03 release? {y,n} [y] y

Enter the full path to the directory where you want to install
Synopsys U-2003.03 products.  If the directory does not exist,
it will be created.  [/usr/synopsys]: /usr/synopsys/U-2003.03

Creating Synopsys root directory /usr/synopsys/U-2003.03 ...
Select Synopsys product(s) to install:
        {
        syn - Core Synthesis Tools
        sf3 - Synopsys Integrator for Falcon Framework MentorC
        sf4 - Synopsys Integrator for Falcon Framework MentorD
        pc  - DALI (Protocol Compiler)
        }
Enter the list of product(s) to install [syn]: syn sf3 pc

Product(s) selected: syn sf3 pc
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Platform Independent Package for a particular product contains
support files that are common to all the platforms.
You must install this package for each product if you
are installing it to the /usr/synopsys/U-2003.03
directory for the first time.

Install Platform Independent Package for syn? {y,n} [y]: y

Install Platform Independent Package for sf3? {y,n} [y]: y

Install Platform Independent Package for pc? {y,n} [y]: y

Platform(s) selected: sparcos5
___________________________________________________________________________

Here is your final selection for installing Synopsys Tools:

    VERSION:   U-2003.03
    PRODUCTS:  syn sf3 pc
    PLATFORMS: sparcos5

    Synopsys Media Directory (from) : /cdrom
    Synopsys Install Directory (to) : /usr/synopsys/U-2003.03

    Platform Independent Package(s) for : syn sf3 pc

    Disk space required             : 1138 MB
    Disk space available            : 12918 MB

If all the information is correct, continue with the installation.

___________________________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

INSTALLING syn product, platform_independent package, U-2003.03 version.
  uncompress < ./syn.taz | ( cd /usr/synopsys/U-2003.03; tar xvfp - )
sparcos5
INSTALLING syn product, sparcos5 package, U-2003.03 version.
  uncompress < ./sparcos5/syn.taz | (cd /usr/synopsys/U-2003.03; tar xvfp - )

INSTALLING sf3 product, platform_independent package, U-2003.03 version.
  uncompress < ./sf3.taz | ( cd /usr/synopsys/U-2003.03; tar xvfp - )
sparcos5
INSTALLING sf3 product, sparcos5 package, U-2003.03 version.
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  uncompress < ./sparcos5/sf3.taz | (cd /usr/synopsys/U-2003.03; tar xvfp - )
INSTALLING pc product, platform_independent package, U-2003.03 version.
  uncompress < ./sf3.taz | ( cd /usr/synopsys/U-2003.03; tar xvfp - )
sparcos5
INSTALLING pc product, sparcos5 package, U-2003.03 version.

Installing Design Compiler ...

Installing Module Compiler ...

Installing power_estimate ...

Installing Library Compiler ...

Installing BC View ...

Installing MemWrap ...

Installing Design Vision ...

Installing Physical Compiler ...

Synopsys Integrator for Falcon Framework Installation Script

Platform [ sparcOS5 ]: sparcOS5

Falcon Framework Version [ C ]: C

Synopsys root directory [ /usr/synopsys/U-2003.03 ]: /usr/synopsys/U-2003.03
Synopsys integrator directory [
/usr/synopsys/U-2003.03/sparcOS5/syn/interfaces/mentorC ]:

Synopsys Site Identification Number appears on the upper right corner
of your Synopsys License Key Certificate.

-n Synopsys Site Identification Number [Hit return for 000]: 000

Synopsys License Administrator is a person who must be contacted
for Synopsys product related administrative tasks at your site.
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-n Local Synopsys License Administrator [Hit return for customer]:

License Administrator Contact is the current phone number and/or
Email address of customer.

-n License Administrator Contact [Hit return for ###-#### and/or user@email]:

Created site file /usr/synopsys/U-2003.03/admin/license/site_info.

Done.

You must now continue with the product-specific installation procedures,
install the Synopsys keys, and start the license servers.

For more information, refer to ./README.{syn sf3 pc} file(s) and
the Installation Guide version U-2003.03.

Thank you ...

Example 2-2 shows a sample Synopsys media installation script for
version U-2003.03 of the PrimeTime tools; it applies to installation by
EST and from the CD. Other version U-2003.03 tools are installed in
a similar manner.

Example 2-2 Synopsys Media Installation Script for PrimeTime
Synopsys Media Installation

Instructions: The list within {} shows the choices for a given option. The entry
within [] shows the default selection when you hit the Return key.  You can
cancel the installation by entering quit when prompted for input.
_________________________________________________________

The current mounted Synopsys CD file system is U-2003.03.

        VERSION:     U-2003.03
        PRODUCTS:    pts
        PLATFORMS:   sparcOS5 sparc64
        PART NUMBER: XXXXXX
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_________________________________________________________
Install U-2003.03 release? {y,n} [y] y

NOTE:  The product(s) pts on this CD-ROM must be installed in a
       standalone directory.

Enter the full path to the directory where you want to install
Synopsys U-2003.03 products.  If the directory does not exist,
it will be created.  [/usr/synopsys]: /usr/synopsys/U-2003.03

Select Synopsys product(s) to install:
        {
        pts - PrimeTime_StandAlone
        }
Enter the list of product(s) to install [pts]: pts

Product(s) selected: pts

The Platform Independent Package for a particular product contains support files
that are common to all the platforms.
You must install this package for each product if you are installing it to the
/usr/synopsys/U-2003.03 directory for the first time.

Install Platform Independent Package for pts? {y,n} [y]: y

Select platform(s) to install:
        {
        sparcOS5 (for Solaris 8, 9)
        sparc64  (for Solaris 8, 9; 64bit Kernel)
        }
Enter the list of platform(s) to install [sparcOS5]: sparcOS5
sparcos5

Platform(s) selected: sparcos5
__________________________________________________________

Here is your final selection for installing Synopsys Tools:

    VERSION:   U-2003.03
    PRODUCTS:  pts
    PLATFORMS: sparcos5

    Synopsys Media Directory (from) : /cdrom
       Synopsys Install Directory (to) : /usr/synopsys/U-2003.03

    Platform Independent Package(s) for : pts

    Disk space required             : 290 MB
    Disk space available            : 10063 MB
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If all the information is correct, continue with the installation.

_________________________________________________________

Install? {y,n} [y]: y

Starting Installation ... Please do not interrupt.

INSTALLING pts product, platform_independent package, U-2003.03 version.
uncompress < ./pts.taz | ( cd /usr/synopsys/U-2003.03; tar xvfp - ) sparcos5
INSTALLING pts product, sparcos5 package, U-2003.03 version.
  uncompress < ./sparcos5/pts.taz | (cd /usr/synopsys/U-2003.03; tar xvfp - )

Installing PrimeTime ...

Synopsys Site Identification Number appears on the upper right corner of your
Synopsys License Key Certificate.

-n Synopsys Site Identification Number [Hit return for 000]:
000

Synopsys License Administrator is a person who must be contacted for Synopsys
product related administrative tasks at your site.

-n Local Synopsys License Administrator [Hit return for ryang]:

License Administrator Contact is the current phone number and/or Email address
of ryang.

-n License Administrator Contact [Hit return for ###-#### and/or user@email]:

Created site file /usr/synopsys/U-2003.03/admin/license/site_info.

Done.

You must now continue with the product-specific installation procedures, install
the Synopsys keys, and start the license servers.

For more information, refer to ./README.{pts} file(s) and
the Installation Guide.

Thank you ...
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Unmounting the CD

To unmount the CD,

1. Move to another directory. For example, enter

% cd /tmp

2. Unmount the CD by using the appropriate command for your
operating system. For example, enter

% umount /cdrom

Note:

If you are running the volume management daemon, use the
eject command to unmount the CD.

3. Remove the CD from the drive.

Installing Tools in the Correct Sequence

Most Synopsys tools are stand-alone products and cannot be
installed into another Synopsys tool directory. However, with
products that allow overlay installation, the installation order is
important. For example, install these tools in the following sequence:

• Synthesis tools

• PrimePower (overlay)

• TetraMAX (overlay)
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Note:
To run the Synopsys tools, Synopsys Common Licensing (SCL)
software must be installed. For details about Synopsys licensing
software, see the Licensing Quick Start document and the
Licensing Installation and Administration Guide, which are
available online at www.synopsys.com/keys.
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Installing the Synopsys Synthesis Tools
(version U-2003.03) 3

This chapter contains the following sections:

• Synthesis Tools

• Installing the Software

• Configuring the Synthesis Tools

• Installing Optional Tools

• Verifying the Synthesis Tools Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).
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• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Beginning with the 2002.05 release, PrimeTime no longer overlays
the synthesis tools.

Synthesis Tools

The Synopsys synthesis tools include the following:

• Core synthesis tools

- Automated Chip Synthesis

- BCView

- Behavioral Compiler

- BSD Compiler

- CoCentric SystemC Compiler

- Design Analyzer

- Design Compiler

- Design Vision

- DesignWare

- DFT Compiler

- EDIF 2 0 0 Interface

- Floorplan Manager
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- HDL Compiler (Presto Verilog)

- Library Compiler

- Module Compiler

- Physical Compiler

- Power Compiler

- Protocol Compiler

- VHDL Compiler

• Synopsys Integrator for Falcon Framework

- Mentor C version

- Mentor D version

If you have purchased any of these tools, you must install the
Synthesis tools suite.

Even though the synthesis tools install as a suite, individual products
within the suite might not be available on all platforms.

Installing the Software

To download and install the synthesis tools from the Web or by FTP,
follow the procedures described in “Downloading and Installing the
Software by EST” on page 2-2.

To transfer the files from the Synthesis CD to your system, follow the
installation procedure described in “Installing Product Files From a
CD” on page 2-6.
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On the sparcOS5 platform, you can choose to install either version
C (sf3) or D (sf4) of the Synopsys Integrator for Falcon Framework
product, but not both. On the hp32 platform, you can install only
version D (sf4).

Example 2-1 on page 2-9 shows a sample Synopsys media
installation script for the synthesis tools.

Configuring the Synthesis Tools

This section describes how to

• Set up the synthesis tools for each user

• Set up the systemwide defaults for Design Analyzer

Setting Up the Synthesis Tools for Each User

To set up a new synthesis tools user,

1. Add the directory for the synthesis executable files to the PATH
environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/syn/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).
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When you install the synthesis files, a copy of the synthesis setup
file is placed in $SYNOPSYS/admin/setup/.synopsys_dc.setup.
The .synopsys_dc.setup file contains the system defaults for the
synthesis tools. You can modify this file to customize the settings
for your environment.

2. Place a .synopsys_dc.setup file in the user’s home directory.

If you are using the C shell, enter

        % cp $SYNOPSYS/admin/setup/.synopsys_dc.setup ~/.synopsys_dc.setup

If you are using the Bourne, Korn, or Bash shell, enter

       # cp $SYNOPSYS/admin/setup/.synopsys_dc.setup $HOME/.synopsys_dc.setup

You can modify this file to customize the settings for each user.

3. To use a graphical user interface (GUI), such as Design Analyzer,
you must also add the X Window System executable files to the
PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=(/usr/dt/bin /usr/bin/X11 $path)

For Solaris 8 or 9, add

set path=(/usr/dt/bin /usr/openwin/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:

PATH=/usr/dt/bin:/usr/bin/X11:$PATH
export PATH

For Solaris 8 or 9, add

PATH=/usr/dt/bin:/usr/openwin/bin/X11:$PATH
export PATH
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Setting Up the Systemwide Defaults

If you are using the Design Analyzer product, you can customize the
display for all users at a site by modifying the Design Analyzer
application defaults (app-defaults) file. This file is placed in the
following location during installation:

$SYNOPSYS/admin/setup/Design_analyzer

To see a list of available colors for the Solaris 7 and 8 platforms,
enter

% more /usr/openwin/lib/X11/rgb.txt

For all other platforms, enter

% more /usr/lib/X11/rgb.txt

To see a list of available fonts, enter

% xlsfonts | more

To install the changes, copy the modified app-defaults file into the
systemwide app-defaults location, which varies from site to site. To
find the systemwide location at your site, contact your system
administrator.

Note:
You must have root access privileges to install this systemwide
defaults file.

If your app-defaults location is in X11 (a common location), install the
Design_analyzer file by entering a command similar to the one in the
following example:

% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/openwin/lib/X11/app-defaults
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% cp $SYNOPSYS/admin/setup/Design_analyzer /usr/lib/X11/app-defaults

You can customize the GUI display for an individual Design Analyzer
user by adding color and font definitions to the .Xdefaults file in each
user’s login directory. Values defined in the .Xdefaults file override
the values in the systemwide app-defaults file.

If you are using the Design Vision or Physical Compiler GUI tools,
see the appropriate online Help system for information about
customizing the tool environment.

Additional SystemC Compiler SetUp for Each User

To set up a CoCentric SystemC Compiler user, in addition to the
other synthesis settings, you must define the absolute path to a C++
compiler and the compiler options.

If you are using the C shell, add the following lines to the .cshrc file:

setenv SYSTEMC_CPP "compiler_home options"

If you are using the Bourne, Korn, or Bash shell, add the following
lines to the .profile, .kshrc, or .bashrc file:

SYSTEMC_CPP=compiler_home options
export SYSTEMC_CPP

For the GNU C++ Compiler version 2.95.2 or later (or version 3.2 for
Linux), replace compiler_home with the absolute path to the GNU
C++ Compiler, and replace options with the typical compiler options
you use. For example,

setenv SYSTEMC_CPP "/usr/local/bin/gcc -E -C"
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For the Sun SparcWorks C++ Compiler (version 5.0 or later), replace
compiler_home with the absolute path to Sun SparcWorks C++
Compiler, and replace options with the typical compiler options you
use. For example,

setenv SYSTEMC_CPP "/usr/local/bin/cc -E -xCC -Xc"

The SystemC Compiler default path to the SystemC library include
files is $SYNOPSYS/auxx/systemc/include. To define a different
path to the SystemC library include files, specify the -I option for
SYSTEMC_CPP. For example,

setenv SYSTEMC_CPP "/usr/local/bin/gcc -E -C
       -I/my_systemc/include"

Configuring the Browser for Physical Compiler and
Design Vision Online Help

The Physical Compiler and Design Vision online Help systems are
browser-based HTML Help systems. For optimal viewing, use
Netscape Navigator version 4.78 for UNIX. These Help systems are
not supported in Netscape Navigator version 6 or later.

Both Help systems make extensive use of Java, JavaScript, and
style sheets. In your browser preferences, select the Advanced
category and make sure that

• The Enable Java, Enable JavaScript, and Enable Style Sheets
options are all selected

• The Enable Java Plugin option is deselected

You can open either Help system from within its respective GUI tool
or open it stand-alone in Netscape Navigator.
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Installing Optional Tools

The synthesis media installation script automatically installs most of
the synthesis tools. However, the following tools require manual
setup or installations:

• Synopsys Integrator for Falcon Framework

• Power Compiler VPOWER

Installing Synopsys Integrator for Falcon Framework

To complete the setup for the Synopsys Integrator for Falcon
Framework product, set the SYNOPSYS_IFF_ROOT environment
variable to point to the Synopsys integrator directory.

When asked for the Falcon Framework version, enter

• C if you selected the sf3 product from the installation script

• D if you selected the sf4 product from the installation script

Note:

You can install Falcon Framework version C or D, but not both.
Version C is supported only on the Solaris 8 (sparcOS5)
operating system; version D is supported on both
HP-UX 11.0 or 11i (hp32) and Solaris 8 (sparcOS5) operating
systems.

If you are using the C shell, add the following line to the .cshrc file:

setenv SYNOPSYS_IFF_ROOT $SYNOPSYS/platform/syn/interfaces/mentorC

If you are using the Bourne, Korn, or Bash shell, add the following
lines to the .profile file:
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SYNOPSYS_IFF_ROOT=$SYNOPSYS/platform/syn/interfaces/mentorC
export SYNOPSYS_IFF_ROOT

Replace platform with one of the following: hp32 or sparcOS5.

Installing Power Compiler VPOWER

VPOWER is the Power Compiler interface to VCS, the Cadence
Verilog-XL and NC-Verilog simulators, and the MTI Verilog simulator.
VPOWER contains user tasks that allow you to monitor toggle
activity during simulation and to output the information in a form
readable by Power Compiler. To use VPOWER, link the user tasks to
the executable file of your simulator.

The following sections describe the steps for static-linking VPOWER
with Verilog-XL and VCS simulators only. For information about
linking VPOWER with other simulators, see the Power Compiler
User Guide.

Verilog-XL Simulator

The following procedure describes how to link VPOWER to a version
of the Verilog-XL simulator that contains the standard features you
normally use at your site and includes the toggle count utilities
needed for Power Compiler.

Note:
You must perform this installation on a machine that has access
to your Verilog-XL simulator vendor distribution.

Consult your Verilog system administrator to obtain the following
information before beginning the VPOWER installation:

• The directory path to your Verilog .o, .a, and .h files
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• The directory location of your central Verilog distribution, for
obtaining a current site copy of the veriuser.c file

This installation requires modification of your veriuser.c file. By
obtaining a current site copy of the veriuser.c file, you can be sure to
include any current site modifications when you modify this file.

To install VPOWER,

1. Change to the Synopsys vpower directory.

2. Modify a copy of your site veriuser.c file.

3. Link the VPOWER user tasks to the simulation executable file.

4. Copy the linked executable file.

The following sections describe these steps.

Changing to the Synopsys power Directory. All directories listed
are relative to the root of the vpower directory: $SYNOPSYS/auxx/
syn/power/vpower.

To change to the Synopsys vpower directory,

1. Make sure the environment variable $SYNOPSYS is set.

% echo $SYNOPSYS

If it is not set, set it to the correct value.

% setenv $SYNOPSYS root_directory

2. Change to the Synopsys vpower directory.

% cd $SYNOPSYS/auxx/syn/power/vpower
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Modifying the veriuser.c File. To modify the veriuser.c file to define
the new toggle count utilities,

1. Change to the vxl/vxl.sample directory, and review the sample
veriuser.c file, which shows the edits you will have to make.

% cd vxl/vxl.sample

2. Copy your current site version of veriuser.c into the sample
directory. To copy veriuser.c, you must know the directory
location of your central Verilog distribution.

% cp site_location_dir_path/veriuser.c .

By using a current site copy of veriuser.c, you ensure that any
existing customizations are included in the VPOWER installation.

3. As shown in the sample veriuser.c file, make the following
changes in your current site copy of veriuser.c:

- Add the following line:

# include "tc_extern.h"

- Add the following user tasks:

{usertask, 0, 0, 0, tc_set, tc_set_sync, "$toggle_set", 1},
{usertask, 0, 0, 0, tc_start, 0, "$toggle_start", 1},
{usertask, 0, 0, 0, tc_stop, 0, "$toggle_stop", 1},
{usertask, 0, 0, 0, tc_reset, 0, "$toggle_reset", 1},
{usertask, 0, 0, 0, tc_compatibility, 0, "$toggle_count", 1},
{usertask, 0, toggle_report_check, 0, toggle_report, 0, "$toggle_report", 0},
{usertask, 0, 0, 0, read_lib_saif, tc_lib_sync, "$read_lib_saif", 1},
{usertask, 0, 0, 0, read_rtl_saif, tc_set_sync, "$read_rtl_saif", 1},

- Comment out the following line:

char *veriuser_version_str = "";

4. Save your modified veriuser.c file.
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5. Exit your text editor and remain in the sample directory to link the
executable file.

Linking User Tasks to the Simulation Executable File.
VPOWER provides two ways to link the user tasks to your simulator
executable file: by using the vconfig utility or by using a UNIX
makefile. Each method links your simulator to the VPOWER user
tasks. Choose the method that you find familiar or comfortable.

Using vconfig to Link the Executable File. The vconfig utility
creates a script called cr_vlog. The cr_vlog script links your
Verilog-XL simulator’s executable file to the VPOWER user tasks.
You must define the name of the executable file created by cr_vlog,
for example, verilog_toggle.

To use the vconfig method to link your executable file,

1. Use your vconfig utility or an equivalent utility to generate the
cr_vlog script or an equivalent script.

2. In the script, set an environment variable pointing to the directory
of the generated library archive. For example (if you are using
Solaris 7 or later),

setenv PPLILIB "../../lib-sparcOS5/libvpower.a"

3. In cr_vlog, look for the line that includes the math libraries:

-lm \

4. Add a line above this line to include the libvpower.a library. For
example,

$PPLILIB \
-lm \

5. Run cr_vlog.
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% cr_vlog

This script links your executable file to the VPOWER user tasks
and creates the customized executable file called verilog_toggle.
For details about linking the programmable language interface
(PLI) by using the vconfig utility, see the Power Compiler User
Guide.

Proceed to “Copying the Linked Executable File” on page 3-15.

Using a Makefile to Link the Executable File. Using the UNIX
make command, you can use a makefile to link your Verilog-XL
executable file to the VPOWER user tasks. The makefile creates a
modified executable file called verilog_toggle.

Two makefiles exist: Makefile.sol and Makefile.hp.

To use the makefile method to link your executable file,

1. Using a text editor such as vi, edit the appropriate makefile to set
variable values for VERILOG_LIB and VERILOG_INC.

Modify the lines in the makefile to read according to your data.
For example, enter

VERILOG_LIB = path1
VERILOG_INC = path2

where path1 is the path to your Verilog distribution .o and .a files,
and path2 is the path to your Verilog distribution .h files.

The VERILOG_LIB variable must point to the directory path of
the vlog.o and omnitasks.o files. The VERILOG_INC variable
must point to the directory path of the acc_user.h and veriuser.h
files.

2. Save the modified makefile and exit your text editor.
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3. Use the make utility to link the executable file.

% make -f Makefile.platform

The platform extension is sol or hp.

The make command uses the modified makefile to link your
executable file, creating a customized executable file called
verilog_toggle.

Copying the Linked Executable File. After you create your
customized executable file, change the permissions so that the file is
not writable, and copy it to a directory suitable for group access.

Enter the following commands at the UNIX prompt:

% chmod ogu-w verilog_toggle

This removes write access to other, group, and user.

% cp verilog_toggle site_verilog_bin_location

This copies the file to the site_verilog_bin_location directory for
group access.

VCS Simulator

The following procedure describes how to link VPOWER to a version
of VCS that contains the standard features you normally use at your
site and includes the toggle count utilities needed for Power
Compiler.

Note:
The PLI library has been tested with VCS version 3.0 and later
versions.
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To install VPOWER,

1. Change to the Synopsys vpower directory.

2. Modify a copy of the PLI table file.

3. Compile the simulation executable file.

The following sections describe these steps.

Changing to the Synopsys vpower Directory. All directories
listed are relative to the root of the vpower directory: $SYNOPSYS/
auxx/syn/power/vpower.

1. Make sure the environment variable $SYNOPSYS is set.

% echo $SYNOPSYS

If it is not set, set it to the correct value.

% setenv $SYNOPSYS synthesis_root_directory

2. Change to the Synopsys vpower directory.

% cd $SYNOPSYS/auxx/syn/power/vpower

Modifying the PLI Table File. To modify the PLI table file
(vpower.tab) to define the new toggle count utilities,

1. Change to the vcs/vcs.sample directory, and review the sample
vpower.tab file, which shows the edits you will have to make.

% cd vcs/vcs.sample

2. Make the necessary changes to the vpower.tab file.
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Compiling the Simulation Executable File. VCS is a compiled
simulator, so you must compile your designs along with VCS libraries
to make a simulation executable file. To add PLI functionality to the
simulation executable file, you need to link an extra PLI library when
you compile your designs.

For Solaris the appropriate PLI library is

../../lib-sparcOS5/libvpower.a

You normally get a VCS simulation executable file by entering the
following command at the UNIX prompt:

% vcs -Mupdate your_verilog_design_files compiler_options

 To link with the PLI library, enter

% vcs -Mupdate \
    -P $SYNOPSYS/auxx/syn/power/vpower/vcs/vcs.sample/vpower.tab \
   your_verilog_design_files compiler_options \
   $SYNOPSYS/auxx/syn/power/vpower/lib-sparcOS5/libvpower.a

This generates an executable file called simv that includes PLI
functionality.

Note:
You can copy vpower.tab and libvpower.a into any file locations
that are convenient for you.
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Verifying the Synthesis Tools Installation

Note:
The Synopsys Common Licensing (SCL) software must be
installed and SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE
must be defined before you can verify the synthesis tools
installation. For information on installing SCL, see “Acquiring a
License” on page 1-16.

To verify installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke one of the synthesis tools on a licensed machine. For
example, invoke Design Compiler, Library Compiler,  Design
Analyzer, or Design Vision by entering one of the following
commands:

% $SYNOPSYS/platform/syn/bin/dc_shell

% $SYNOPSYS/platform/syn/bin/lc_shell

% $SYNOPSYS/platform/syn/bin/design_analyzer

% $SYNOPSYS/platform/syn/bin/design_vision

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6). Note that not all
dc_shell-based tools install on all platforms listed under
“Synthesis.” For information about tool-specific platform support,
see the documentation for your product.
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Note:
You can verify other synthesis tools by using the preceding
command. Simply replace the executable file name with the
name of another synthesis tool.

If you get the correct prompt, or if a GUI appears, the installation was
successful.
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Installing AMPS (version U-2003.03) 4

This chapter contains the following sections:

• Installing the Software

• Setting Up AMPS for Each User

• Verifying the AMPS Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install AMPS from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the AMPS software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. AMPS is installed in a similar
manner.

The AMPS tool is on the PathMill CD. AMPS is a stand-alone product
and cannot be installed over an existing Synopsys product, including
a prior version of AMPS. You must create a new directory for AMPS.

Setting Up AMPS for Each User

To set up a new AMPS tool user, add the AMPS directory containing
the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/amps/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/amps/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and
Supported Platforms” on page 1-6).
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Verifying the AMPS Installation

To verify the AMPS installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% $SYNOPSYS/platform/amps/bin/amps

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

If you see information about the product version, production date,
and copyright, the installation was successful.
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Installing Arcadia (version U-2003.03) 5

This chapter contains the following sections:

• Installing the Software

• Setting Up Arcadia for Each User

• Verifying the Arcadia Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install Arcadia from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the Arcadia software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-1 on page 2-9 shows a Synopsys media
installation script for the synthesis tools. Arcadia is installed in a
similar manner.

Arcadia is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of Arcadia. You
must create a new directory for Arcadia.

Note:
The installation procedure for Arcadia has changed with this
release. Arcadia now installs by using the install.now script.

Setting Up Arcadia for Each User

To set up a new Arcadia tool user,

• If you are using the C shell, source the CSHRC_platform file
located in the install directory.

% cd install dir
% source CSHRC_platform

The install script for Arcadia creates a CSHRC_platform file for
each platform installed. The term platform is replaced with the
platform you installed.
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The CSHRC_platform file contains the line

set path=(/install_directory/platform/arc/bin $path)

where install_directory is the directory in which the tool has been
installed.

If you don’t source the CSHRC_platform file, copy the preceding
line and set the path from that file.

• If you are using the Bourne or Korn shell, add the following line
to the .profile file or .kshrc file:

PATH=/install_directory/platform/arc/bin:${PATH}
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Verifying the Arcadia Installation

To verify the Arcadia installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% DBCONVERT --version

If you see information about the product version, production date,
and copyright, the installation was successful.
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3. Run the Arcadia GUI on each installed platform by entering the
following command:

% $SYNOPSYS/platform/arc/bin/sviewer

4. Exit the GUI by choosing File > Exit in any GUI window.
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Installing CoCentric Fixed-Point Designer
(version U-2003.03) 6

This chapter contains the following sections:

• Installing the Software

• Installing the SystemC Software

• Setting Up CoCentric Fixed-Point Designer for Each User

• Verifying the CoCentric Fixed-Point Designer Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Note:
For detailed information on operating systems and acquiring
patches, see “Supported Platforms and Operating Systems” on
page 1-2.

Installing the Software

To download and install CoCentric Fixed-Point Designer from the
Web or by FTP, follow the procedures described in “Downloading and
Installing the Software by EST” on page 2-2.

To install the CoCentric Fixed-Point Designer software from the CD,
follow the installation procedure described in “Installing Product Files
From a CD” on page 2-6. Example 2-1 on page 2-9 shows a
Synopsys media installation script for the synthesis tools. CoCentric
Fixed-Point Designer is installed in a similar manner.

Installing the SystemC Software

During the CoCentric Fixed-Point Designer installation process, a
compressed tar file containing the compiled version of SystemC
2.0.1 was copied to $SYNOPSYS/ccfxd.

To install SystemC,

1. Copy the $SYNOPSYS/ccfxd/SystemC-2.0.1.bin.tar.Z file to the
directory in which you want to install SystemC.

2. Uncompress and untar the file.
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3. Set the SYSTEMC_HOME environment variable to point to the
SystemC 2.0.1 installation directory.

Setting Up CoCentric Fixed-Point Designer for Each
User

Set the systemwide defaults for each user according to the user’s
shell and operating system. Table 6-1 lists the path name and
description of systemwide defaults for CoCentric Fixed-Point
Designer.

Note:
If you are using CoCentric Fixed-Point Designer with CoCentric
System Studio, you must set the corresponding System Studio
environment variables.

Table 6-1 CoCentric Fixed-Point Designer Systemwide Defaults

Path name Description

SYNOPSYS Identifies the installation directory for Synopsys
tools.

SYNOPSYS_CCFXD Identifies the CoCentric Fixed-Point Designer
installation directory. For example,
$SYNOPSYS/sparcOS5/ccfxd.

$SYNOPSYS_CCSS Identifies the CoCentric System Studio
installation directory. For example,
$SYNOPSYS/sparcOS5/ccss.

SYSTEMC_HOME Identifies the SystemC installation directory.

CCFXD_KEYS Specifies the complete file name of the license
file. If CCFXD_KEYS is not set, the tool searches
for other license keys in the following order:

SNPSLMD_LICENSE_FILE
LM_LICENSE_FILE
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The CoCentric Fixed-Point Designer installation script creates the
following files and puts them into the $SYNOPSYS/admin/install
directory:

• environ.csh (C shell)

• environ.sh (Bourne, Korn, or Bash shell)

You might need to modify these files to customize the settings for
your environment.

To add CoCentric Fixed-Point Designer to each user’s environment,
add the following commands to the end of each user’s startup file.

• If you are using the C shell, add this command to the end of the
.cshrc file:

source $SYNOPSYS/admin/install/ccfxd/bin/environ.csh

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:

. $SYNOPSYS/admin/install/ccfxd/bin/environ.sh

Verifying the CoCentric Fixed-Point Designer
Installation

To verify the CoCentric Fixed-Point Designer installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% ccfxd
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If CoCentric Fixed-Point Designer is correctly installed, this
command invokes the tool, displays the welcome screen, and then
opens CoCentric Fixed-Point Designer Studio.
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Installing CoCentric System Studio
(version U-2003.03) 7

This chapter contains the following sections:

• Installing the Software

• Setting Up CoCentric System Studio for Each User

• Verifying the CoCentric System Studio Installation

• Troubleshooting Startup Problems

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Note:
CoCentric System Studio works with certain versions of Solaris
and HP-UX platforms in combination with a C++ compiler. A new
platform, Solaris 8 or 9 (32-bit mode) with the GCC compiler, is
available for the CoCentric System Studio tool. To install this
version of CoCentric System Studio, use gccsparcOS5 as the
platform keyword.

For detailed information on operating systems and acquiring
patches, see “Supported Platforms and Operating Systems” on
page 1-2.

Installing the Software

To download and install CoCentric System Studio from the Web or
by FTP, follow the procedures described in “Downloading and
Installing the Software by EST” on page 2-2.

To install the CoCentric System Studio software from the CD, follow
the installation procedure described in “Installing Product Files From
a CD” on page 2-6. Example 2-1 on page 2-9 shows a Synopsys
media installation script for the synthesis tools. CoCentric System
Studio is installed in a similar manner.
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Setting Up CoCentric System Studio for Each User

This section describes how to set up CoCentric System Studio for
each user on Solaris and HP-UX platforms.

Set the defaults for each user according to the user’s shell and
operating system. Table 7-1 lists the path name and description of
systemwide defaults for CoCentric System Studio.

For C Shell Users

To use the C shell to set up a new CoCentric System Studio tool user,

1. Add the CoCentric System Studio executable directory to the
PATH environment variable.

Add the following line to the .cshrc file:

setenv SYNOPSYS_CCSS ccss_home/platform/ccss
setenv CCSS_SIM_DIR ccss_sim_dir
set path = ($SYNOPSYS_CCSS/bin $path)

Table 7-1 CoCentric System Studio Systemwide Defaults

Path name Description

SYNOPSYS_CCSS Identifies the CoCentric System Studio
installation directory. For example,
$SYNOPSYS/sparcOS5/ccss.

CCSS_SIM_DIR Path to the directory for code generation and
simulation results (defaults to $HOME/ccss/sim)

CCSS_KEYS Specifies the complete file name of the license
file. If CCSS_KEYS is not set, the tool searches
for other license keys in the following order:
- SNPSLMD_LICENSE_FILE
- LM_LICENSE_FILE
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Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Note:

You can define CCSS_SIM_DIR, but if it is not set, the GUI
provides a reasonable default.

2. Point to your license key file by adding one of the following lines
to your ~/.cshrc file:

setenv CCSS_KEYS   /path/to/synopsys.lic

or
setenv SNPSLMD_LICENSE_FILE /path/to/synopsys.lic

3. If the paths to the C++ compiler, debugger, and make command
are not already included in your ~/.cshrc file, add the following
line to your ~/.cshrc file:

set path = (compiler_home/bin make_home/bin $path)

4. To source the CCSS setup file, add the following line to your
~/.cshrc file:

 source $SYNOPSYS_CCSS/../gnupackages/source_me.csh

5. Make these changes effective by logging out and logging in again
or by entering the following command:

% source ~/.cshrc

For Bourne Shell Users

To use the Bourne, Korn, or Bash shell to set up a new user,

1. In your $HOME directory, add the following lines to the
appropriate user setup file (.profile, .kshrc, or .bashrc).

SYNOPSYS_CCSS=ccss_home/platform/ccss
export SYNOPSYS_CCSS
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CCSS_SIM_DIR=ccss_sim_dir
export CCSS_SIM_DIR

PATH=$SYNOPSYS_CCSS/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Note:

You can define CCSS_SIM_DIR, but if it is not set, the GUI
provides a reasonable default.

2. If the System Studio license file will not be installed in the default
location, add the following lines to your setup file:

CCSS_KEYS=lic_file
export CCSS_KEYS

3. If the paths to the C++ compiler, debugger, and make command
are not already included in your setup file, add the following lines
to it:

PATH=compiler_home/bin:make_home/bin:$PATH
export PATH

4. To source the CCSS setup file, add the following line to your
setup file:

. $SYNOPSYS_CCSS/../gnupackages/source_me.sh

5. Make these changes effective by logging out and logging in
again, or by entering

 $. $HOME/setup_file

where setup_file is .profile, .kshrc, or .bashrc.
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VHDL Simulation

If you intend to use the external simulation interface for VHDL
cosimulation under the algorithmic domain of System Studio, you
must ensure that the VHDL packages are analyzed before you use
them. Your system administrator should analyze the files when
System Studio is installed.

The relevant commands are

% cd $SYNOPSYS_CCSS/packages/vsscli/src
% vhdlan -nc ccss_vsscli_package.vhdl
% cd $SYNOPSYS_CCSS/platform/ccss/packages/bittrue/vhdlsynopsys/src
% vhdlan -nc ccss_PACKAGE_SYNOPSYS.vhdl LIB_0_0_1_PACKAGE_SYNOPSYS.vhdl

Verifying the CoCentric System Studio Installation

To verify the CoCentric System Studio installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% ccss &

If System Studio is correctly installed, this command invokes System
Studio, displays the System Studio welcome screen, and then opens
System Studio.
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Troubleshooting Startup Problems

This section addresses common startup problems.

Key File Problems

To test the System Studio installation, start the System Studio
Design Center. If the software does not start, check the contents of
the key file as follows:

1. If you are using a network license file, check the first line of the
key file and make sure the host name and the host ID match
those of the machine on which the license is running.

SERVER hostname hostid 26585

2. If you are using a network license file, check the second line of
the key file and make sure the path to snpslmd exists and is
correct.

VENDOR snpslmd scl_root/platform/bin/snpslmd

In this line, platform is the operating system keyword (see
Table 1-1 on page 1-2). Make sure there are no blank lines and
no leading or trailing spaces in the license file.

3. For all types of license files, make sure that all System Studio
users have read access to the key file.

Set the file permission for the key file with the following
command:

% chmod 644 $CCSS_KEYSS/ccss/admin/license/CCSS.keys

Or, if you have defined the symbol CCSS_KEYS, use this
command:
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% chmod 644 $CCSS_KEYS

Then use the following command to check that the read access
is correct:

% ls -l $SYNOPSYS_CCSS/../../ccss/admin/license/CCSS.keys

You should see a report something like this:

-rw-r--r-- 1 thisuser group 4623 Apr 26 11:09 ccss.keys

Insufficient Interprocess Communication (IPC)
Semaphores

When starting CoCentric System Studio or CoCentric DAVIS on
Solaris 5.x platforms, if you see the following report,

sem_create->semget->IPC_CREATE: No space left on device
GMA failed
FATAL: Exec_ .../sparcOS5/ccss/bin/ccss_exec_ failed:status = 139

you need to increase the number of system semaphores. Add the
following command to the /etc/system file (see the man page
system(4) for details):

set semsys:seminfo_semmnu=0x100

After you change the /etc/system file, restart your system by using
boot -r.

Caution!
Changing the /etc/system file incorrectly will prevent the
system from starting.
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Installing Floorplan Compiler
(version U-2003.03) 8

This chapter contains the following sections:

• Installing the Software

• Setting Up Floorplan Compiler for Each User

• Verifying the Floorplan Compiler Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Installing the Software

To download and install Floorplan Compiler from the Web or by FTP,
follow the procedures described in “Downloading and Installing the
Software by EST” on page 2-2.

To install the Floorplan Compiler software from the CD, follow the
installation procedure described in “Installing Product Files From a
CD” on page 2-6. Example 2-1 on page 2-9 shows a Synopsys
media installation script for the synthesis tools. Floorplan Compiler
is installed in a similar manner.

Setting Up Floorplan Compiler for Each User

To set up a new Floorplan Compiler tool user, add the Floorplan
Compiler directory containing the executable file to the PATH
environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/fpc/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/fpc/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and
Supported Platforms” on page 1-6).
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Configuring the Browser for Floorplan Compiler Online
Help

The Floorplan Compiler online Help system is a browser-based
HTML Help system. For optimal viewing, use Netscape Navigator
version 4.78 for UNIX. This Help system is not supported in
Netscape Navigator version 6 or later.

Floorplan Compiler Help makes extensive use of Java, JavaScript,
and style sheets. In your browser preferences, select the Advanced
category and make sure that

• The Enable Java, Enable JavaScript, and Enable Style Sheets
options are all selected

• The Enable Java Plugin option is deselected

You can open the Help system from within the Floorplan Compiler
GUI tool or stand-alone in Netscape Navigator.

Verifying the Floorplan Compiler Installation

To verify the Floorplan Compiler installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% $SYNOPSYS/platform/fpc/bin/fpc_shell

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).
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If you see information about the product version, production date,
and copyright, the installation was successful.

3. Exit fpc_shell by entering exit on the command line.

4. Run the Floorplan Compiler GUI on each installed platform by
entering the following command:

% $SYNOPSYS/platform/fpc/bin/fpc_gui

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

5. Exit the GUI by choosing File > Exit in any GUI window.
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Installing Formality (version U-2003.03) 9

This chapter contains the following sections:

• Installing the Software

• Setting Up Formality for Each User

• Verifying the Formality Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install Formality from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the Formality software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for the PrimeTime tool. Formality is installed in a
similar manner.

Formality is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of Formality. You
must create a new directory for Formality.

Setting Up Formality for Each User

To set up a new Formality tool user, add the Formality directory
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/fm/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:

PATH=$SYNOPSYS/platform/fm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and
Supported Platforms” on page 1-6).
9-2

Chapter 9: Installing Formality (version U-2003.03)



For information about the Synopsys setup file, see the Formality
User Guide.

Verifying the Formality Installation

To verify the Formality installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the Formality shell by entering the following command:

% $SYNOPSYS/platform/fm/bin/fm_shell

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

If you see information about the product version, production date,
and copyright, the installation was successful.

3. Exit fm_shell by entering exit on the command line.

4. Run the Formality GUI on each installed platform by entering the
following command:

% $SYNOPSYS/platform/fm/bin/formality

5. Exit the GUI by choosing File > Exit in any GUI window.
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Installing FPGA Compiler II
(version 2002.05-3.7) on UNIX Platforms 10

This chapter explains how to install FPGA Compiler II on a
workstation running Solaris or HP-UX. For instructions on how to
install FPGA Compiler II on a system running a Windows NT
platform, see Chapter 11, “Installing FPGA Compiler II (version
2002.05-FC3.7) on Windows Platforms.”

This chapter contains the following sections:

• Product Support

• System Requirements

• Installing the Software

• Enabling Online Document Readers
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Product Support

The FPGA Solutions Web page is regularly updated. Check it for
application notes, online Help updates, and other valuable
information:

http://www.synopsys.com/products/fpga/

For additional installation instructions, go to

http://www.synopsys.com/products/fpga/install_fc2.htm

System Requirements

Table 10-1 shows the minimum system requirements for UNIX
installations of FPGA Compiler II.

Table 10-1 UNIX System Requirements

Operating system Memory Disk space for installation

Solaris 7, 8
 (32-bit mode only)

64 MB of RAM

140 MB of swap space1

1. 200 MB of virtual memory (RAM + swap space) is recommended for most designs. Larger
designs might require more memory.

100–150 MB

HP-UX 11.0, 11.11 (11i)
(32-bit mode only)

64 MB of RAM

140 MB of swap space1
100–150 MB
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Installing the Software

Mounting the CD might require root access privileges. If you do not
have root access privileges, see your system administrator for
instructions on mounting the CD.

To install FPGA Compiler II,

1. Mount the CD-ROM, following the instructions in “Mounting the
CD” on page 2-7.

2. Make sure that your licensing software is installed. For
information on Synopsys Common Licensing (SCL) software,
see “Acquiring a License” on page 1-16.

3. Change directory to the UNIX directory of the CD-ROM. For
example,

% cd /cdrom0/UNIX

4. Run the setup script setup.csh from the UNIX directory of the
CD-ROM drive and follow the instructions.

5. For a typical shared installation, choose option 1 to install the
software and set up the license path.

6. Next, choose option 1 for Solaris, option 2 for HP-UX, or option 3
for both platforms.

7. Enter the path to the network keys in the format port@hostname
(for example, 27000@keyserv).
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Enabling Online Document Readers

The FPGA Compiler II User Guide is available online in Portable
Document Format (PDF).

To read this online document, you must have version 4.0 or later of
Adobe Acrobat Reader with Search plug-in installed on your system.
To install Acrobat Reader with Search plug-in, download the latest
version of Acrobat Reader from the Adobe home page, at

http://www.adobe.com

For more information, see “Downloading Acrobat Reader from the
Web” on page 24-3.
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Installing FPGA Compiler II (version
2002.05-FC3.7) on Windows Platforms 11

You can install the FPGA Compiler II software to run PC running
Windows. The procedure is explained in the following sections:

• Product Support

• System Requirements for Windows

• Installing FPGA Compiler II

• Enabling Online Document Readers
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Product Support

The FPGA Solutions page on the Synopsys World Wide Web site is
regularly updated with the latest information. Check this page to find
application notes, online help updates, and other valuable
information:

http://www.synopsys.com/products/fpga/

For additional installation instructions, go to

http://www.synopsys.com/products/fpga/install_fc2.htm

System Requirements for Windows

Table 11-1 shows the minimum system requirements for installing
FPGA Compiler II on Windows.

Table 11-1 Windows System Requirements

Operating system Memory Disk space for installation

Windows NT 4.0 (Service Pack
4 or later), Windows 98,
Windows ME, or Windows 2000

32 MB of RAM

70 MB of swap space1

1. 100 MB of virtual memory (RAM + swap space) is recommended for most designs. Larger designs
might require more memory.

50–270 MB, depending on file
system and partition size (50
MB for NTFS or small FAT
partition and 270 MB for large
FAT partition)
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Installing FPGA Compiler II

You can install FPGA Compiler II on a PC running Windows by
downloading the tool from the Web or installing it from the CD.

Note:
Make sure that your licensing software is installed. For
information on Synopsys Common Licensing (SCL) software,
see “Acquiring a License” on page 1-16.

To install FPGA Compiler II from the Web,

• Go to

http://www.synopsys.com/products/fpga/download_fc2.html

and follow the instructions.

To install FPGA Compiler II from the CD, do the following:

1. Insert the FPGA Compiler II CD into your computer’s CD drive.

In most cases, the setup program automatically starts. If the
setup program does not start automatically, run setup.exe from
the CD directory.

2. Follow the instructions on the screen.

As you move through the installation screens, note the following:

- You can install a subset of the available target devices to save
disk space. To do this, select Custom in the Setup Type dialog
box and follow the instructions.
11-3

Installing FPGA Compiler II



- The program installation directory path cannot contain space
characters.

Enabling Online Document Readers

The FPGA Compiler II User Guide is available online in Portable
Document Format (PDF). The setup program installs this document
in the directory where you installed the software.

To read the Synopsys FPGA online document, you must have Adobe
Acrobat Reader version 4.0 or later installed on your system. Install
Acrobat Reader version 4.0 by one of the following methods:

• To install Acrobat Reader on a Windows system from within
FPGA Compiler II, enter the following command:

CD_ROM_drive:\acrosrch\32bit\setup

• Download the latest Acrobat Reader from the Adobe home page,
at

http://www.adobe.com

For more information, see “Downloading Acrobat Reader from
the Web” on page 24-3.
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Installing NanoSim (version U-2003.03) 12

This chapter contains the following sections:

• Installing the Software

• Setting Up NanoSim for Each User

• Verifying the NanoSim Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install NanoSim from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the NanoSim software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. NanoSim is installed in a similar
manner. The NanoSim subtools (ADFMI, NanoSim Integration with
VCS, turboWave, Verilog-A, and VTRAN) are automatically installed
with the NanoSim installation.

NanoSim can be installed as a stand-alone installation or with any of
the tools (PowerMill and TimeMill) it comes packaged with.

Setting Up NanoSim for Each User

To set up a new NanoSim tool user,

• If you are using the C shell, source the CSHRC_platform file
located in the install directory.

% cd install dir
% source CSHRC_platform

The install script for NanoSim creates a CSHRC_platform file for
each platform installed. The term platform is replaced with the
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)
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where install_directory is the directory where the tool has been
installed.

If you don’t source the CSHRC_platform file, copy the above line
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:

PATH=/install_directory/platform/ns/bin:${PATH}
export Path

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Verifying the NanoSim Installation

To verify the NanoSim installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% nanosim

If you see information about the product version, production date,
and copyright, the installation was successful.

3. Run the NanoSim GUI on each installed platform by entering the
following command:

% $SYNOPSYS/platform/ns/bin/nanosimgui

4. Exit the GUI by choosing File > Exit in any GUI window.
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Installing PathMill (version U-2003.03) 13

This chapter contains the following sections:

• Installing the Software

• Setting Up PathMill for Each User

• Verifying the PathMill Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
13-1



Installing the Software

To download and install PathMill from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the PathMill software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. PathMill is installed in a similar
manner.

PathMill is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of PathMill. You
must create a new directory for PathMill.

Setting Up PathMill for Each User

To set up a new PathMill tool user, add the PathMill directory
containing the executable file to the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/pm/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=$SYNOPSYS/platform/pm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products and
Supported Platforms” on page 1-6).
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Verifying the PathMill Installation

To verify the PathMill installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% $SYNOPSYS/platform/pm/bin/pathmill

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

If you see information about the product version, production date,
and copyright, the installation was successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PowerArc for Each User

• Verifying the PowerArc Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
14-1



Installing the Software

To download and install PowerArc from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the PowerArc software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. PowerArc is installed in a similar
manner.

PowerArc can be installed as a stand-alone installation or with any of
the tools (PowerMill, NanoSim, and TimeMill) it comes packaged
with.

Setting Up PowerArc for Each User

To set up a new PowerArc tool user,

• If you are using the C shell, source the CSHRC_platform file
located in the install directory.

% cd install dir
% source CSHRC_platform

The install script for PowerArc creates a CSHRC_platform file for
each platform installed. The term platform is replaced with the
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)
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where install_directory is the directory where the tool has been
installed.

If you don’t source the CSHRC_platform file, copy the above line
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=/install_directory/platform/ns/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Verifying the PowerArc Installation

To verify the PowerArc installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% pwarc

If you see information about the product version, production date,
and copyright, the installation was successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PowerMill for Each User

• Verifying the PowerMill Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install PowerMill from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the PowerMill software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. PowerMill is installed in a similar
manner. The PowerMill subtools (ADFMI, turboWave, and VTRAN)
are automatically installed with the PowerMill installation.

PowerMill can be installed as a stand-alone installation or with any of
the tools (NanoSim and TimeMill) it comes packaged with.

Setting Up PowerMill for Each User

To set up a new PowerMill tool user,

• If you are using the C shell, source the CSHRC_platform file
located in the install directory.

% cd install dir
% source CSHRC_platform

The install script for PowerMill creates a CSHRC_platform file for
each platform installed. The term platform is replaced with the
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)
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where install_directory is the directory where the tool has been
installed.

If you don’t source the CSHRC_platform file, copy the above line
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=/install_directory/platform/ns/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Verifying the PowerMill Installation

To verify the PowerMill installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% powrmill

If you see information about the product version, production date,
and copyright, the installation was successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up PrimePower for Each User

• Verifying the PrimePower Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
16-1



Installing the Software

PrimePower can be installed as a stand-alone product or as an
overlay to the U-2003.03 version of the synthesis tools.

• Stand-alone

Install PrimePower stand-alone in its own directory.

• Overlay

Install PrimePower overlay in the same directory as the
Synopsys synthesis tools.

Stand-Alone Installation

PrimePower stand-alone must be installed in its own directory and
not over an existing synthesis release.

To perform stand-alone installation,

1. Download and install PrimePower from the Web or by FTP,
following the instructions described in “Downloading and
Installing the Software by EST” on page 2-2.

Or

Install the files from the PrimePower CD to your system, as
explained in “Installing Product Files From a CD” on page 2-6.
Example 2-1 on page 2-9 shows a Synopsys media installation
script for the synthesis tools. PrimePower is installed in a similar
manner.
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Note:

When you are prompted to select the product you want to
install, enter pps to perform a stand-alone installation.

2. Make sure that your licensing software is installed. For
information on SCL software, see “Acquiring a License” on
page 1-16.

Overlay Installation

You perform overlay installation in the directory in which you installed
the Synopsys synthesis tools ($SYNOPSYS). You must log in as the
same user who installed the Synopsys synthesis tools so that you
have write permission in the $SYNOPSYS directory.

Note:
If you have not installed the Synopsys synthesis tools, install
them before proceeding with overlay installation (see Chapter 3).
If you do not have the synthesis tools installed, the installation of
PrimePower overlay will not be allowed.

To perform overlay installation,

1. Download and install PrimePower from the Web or by FTP,
following the procedures described in “Downloading and
Installing the Software by EST” on page 2-2.

Or

Install the files from the PrimePower CD to your system, as
explained in “Installing Product Files From a CD” on page 2-6.
Example 2-1 on page 2-9 shows a Synopsys media installation
script for the synthesis tools. PrimePower is installed in a similar
manner.
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Note:

When you are prompted to select the product you want to
install, enter pp to perform an overlay installation.

2. Make sure your Synopsys license server and license key file are
set up to work with the synthesis tools. If you encounter
problems, see the SCL documentation, Licensing Quick Start
and Licensing Installation and Administration Guide.

Setting Up PrimePower for Each User

To set up a new PrimePower tool user for stand-alone installation,

1. Add the PrimePower directory containing the executable file to
the PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=(/install_directory/platform/syn/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=/install_directory/platform/syn/bin:$PATH
export PATH
PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

2. Place a .synopsys_pp.setup file in the user’s home directory.

If you are using the C shell, enter

% cp $SYNOPSYS/admin/setup/.synopsys_pp.setup ~/.synopsys_pp.setup

If you are using the Bourne, Korn, or Bash shell, enter
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# cp $SYNOPSYS/admin/setup/.synopsys_pp.setup $HOME/.synopsys_pp.setup

You can modify this file to customize the settings for each user.

Note:

This step is optional. You can still run PrimePower if you do not
set this file in the user’s home directory.

Verifying the PrimePower Installation

To verify the PrimePower installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% pp_shell

If you see information about the product version, production date,
and copyright, the installation was successful.

3. Exit pp_shell by entering exit on the command line.
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4. Run the PrimePower GUI on each installed platform by entering
the following command:

% primepower &

5. Exit the GUI by choosing File > Exit in any GUI window.
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Installing the PrimeTime Tools
(version U-2003.03) 17

This chapter contains the following sections:

• Installing the Software

• Setting Up PrimeTime for Each User

• Verifying the PrimeTime and budget_shell Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Installing the Software

To download and install PrimeTime from the Web or by FTP, follow
the procedures described in “Downloading and Installing the
Software by EST” on page 2-2.

To install the PrimeTime software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime.

PrimeTime is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of PrimeTime.
You must create a new directory for PrimeTime.

Note:
Beginning with the 2002.03 release of PrimeTime, you can no
longer overlay PrimeTime on the synthesis tools.

Using the PrimeTime Budgeter

After installing PrimeTime, if you want to use the PrimeTime
budgeter in the Automatic Chip Synthesis flow, add the following
lines to the .synopsys_dc.setup file in the synthesis directory:

set acs_use_dc_gate_level_budgeting false
set acs_bs_exec /path/to/budget_shell

By default, Automatic Chip Synthesis uses the Design Compiler
budgeter.
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Setting Up PrimeTime for Each User

PrimeTime does not require the $SYNOPSYS variable. If you have
installed other Synopsys tools, such as the synthesis tools, that use
the $SYNOPSYS variable, a conflict might arise. To avoid this, do the
following:

• Set another variable for PrimeTime, for example, $STATIC.

• Set the PrimeTime $SYNOPSYS variable in a tool-specific setup
file, not in the .profile or .cshrc file.

• Create an alias for PrimeTime in the .cshrc, .profile, or .bashrc
files. For example,

For .cshrc files,

% alias pt_setup 'setenv SYNOPSYS /path/to/PrimeTime_root; echo
"PrimeTime tools setup "'

For .profile or .bashrc files,

% alias pt_setup = 'set SYNOPSYS=/path/to/PrimeTime_root; echo
"PrimeTime tools setup"'

 Execute the alias before executing PrimeTime.

To set up a new PrimeTime user,

1. Add the PrimeTime directory containing the executable file to the
PATH environment variable.

If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS/platform/syn/bin $path)

If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:
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PATH=$SYNOPSYS/platform/syn/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Note:

If you are using another variable “such as $STATIC” to define
the PrimeTime root directory, substitute that variable for
$SYNOPSYS in the remainder of this chapter.

2. Place a .synopsys_pt.setup file in the user’s home directory.

If you are using the C shell, enter

  % cp $SYNOPSYS/admin/setup/.synopsys_pt.setup ~/.synopsys_pt.setup

If you are using the Bourne, Korn, or Bash shell, enter

  # cp $SYNOPSYS/admin/setup/.synopsys_pt.setup $HOME/.synopsys_pt.setup

You can modify this file to customize the settings for each user.
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Verifying the PrimeTime and budget_shell Installation

Note:
The Synopsys Common Licensing (SCL) software must be
installed and SNPSLMD_LICENSE_FILE or LM_LICENSE_FILE
must be defined before you can verify the PrimeTime tools
installation. For information on installing SCL, see “Acquiring a
License” on page 1-16.

To verify installation of the PrimeTime and budget_shell tools,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke any of the tools by entering one of the following
commands on a licensed machine:

% $SYNOPSYS/platform/syn/bin/pt_shell

% $SYNOPSYS/platform/syn/bin/budget_shell

% $SYNOPSYS/platform/syn/bin/primetime

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

If you get the correct prompt, or if a GUI appears, the installation was
successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up RailMill for Each User

• Verifying the RailMill Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install RailMill from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the RailMill software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-1 on page 2-9 shows a Synopsys media
installation script for the synthesis tools. RailMill is installed in a
similar manner.

RailMill is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of RailMill. You
must create a new directory for RailMill.

Note:
The installation procedure for RailMill has changed. RailMill now
installs by using the Synopsys ./.install.now script.

Setting Up RailMill for Each User

To set up a new RailMill tool user,

• If you are using the C shell, source the CSHRC_platform file
located in the install directory.

% cd install dir
% source CSHRC_platform

The install script for RailMill creates a CSHRC_platform file for
each platform installed. The term platform is replaced with the
platform you installed.
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The CSHRC_platform file contains the line

set path=(/install_directory/platform/rm/bin $path)

where install_directory is the directory where the tool has been
installed.

If you don’t source the CSHRC_platform file, copy the above line
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=/install_directory/platform/rm/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Verifying the RailMill Installation

To verify the RailMill installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% railmill

If you see information about the product version, production date,
and copyright, the installation was successful.

3. Run the RailMill GUI on each installed platform by entering the
following command:
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% $SYNOPSYS/platform/rm/bin/chipviewer

4. Exit the GUI by choosing File > Exit, and clicking Yes in the dialog
box.
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This chapter contains the following sections:

• Installing TetraMAX

• Setting Up the User Environment

• Verifying the TetraMAX Installation

If you are installing TetraMAX stand-alone, to ensure a successful
installation complete the following procedures before beginning the
installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).
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• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Installing TetraMAX

This section describes Synopsys license key requirements and the
two types of installation for TetraMAX ATPG and TetraMAX IddQTest,
version U-2003.03:

• Stand-alone

Install TetraMAX stand-alone in its own directory.

• Overlay

Install TetraMAX overlay in the same directory as the U-2003.03
synthesis tools.

License Key Requirements

TetraMAX version U-2003.03 uses the Synopsys Common Licensing
(SCL) system. For information on installing SCL, see “Acquiring a
License” on page 1-16.

Note:
Optional features such as Diagnosis, IddQTest, PatternMap, and
transition delay fault ATPG each require a separate license. For
specific information on the licenses required for TetraMAX
options, install the product and see the online Help for the
“Understanding TetraMAX License Usage.”
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64-Bit Mode on HP-UX and Solaris Platforms

In 64-bit mode, TetraMAX supports both the shell and GUI on HP-UX
and Solaris platforms.

To invoke TetraMAX ATPG in 64-bit mode, use the -64 switch:

% tmax -64 [other options]

An alternative method is to set the TMAX_64BIT environment
variable to true (or to any string other than null):

% setenv TMAX_64BIT true
% tmax [other options]

Stand-Alone Installation

TetraMAX stand-alone is a complete installation of all TetraMAX
applications. It must be installed in its own directory and not over an
existing synthesis release.

To perform stand-alone installation,

1. Download and install TetraMAX from the Web or by FTP, as the
described in “Downloading and Installing the Software by EST”
on page 2-2.

Or

Install the files from the TetraMAX CD to your system, as
explained in “Installing Product Files From a CD” on page 2-6.
Example 2-1 on page 2-9 shows a Synopsys media installation
script for the synthesis tools. TetraMAX is installed in a similar
manner.
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Note:

When you are prompted to select the product you want to
install, enter txs to perform a stand-alone installation.

2. Make sure that your licensing software is installed. For
information on SCL software, see “Acquiring a License” on
page 1-16.

Overlay Installation

Install TetraMAX version version U-2003.03 over version U-2003.03
of the synthesis tools only. (Do not install it over any other versions
of the synthesis tools.)

You perform overlay installation in the directory in which you installed
the Synopsys synthesis tools ($SYNOPSYS). You must log in as the
same user who installed the Synopsys synthesis tools so that you
have write permission in the $SYNOPSYS directory.

Note:
If you have not installed the Synopsys synthesis tools, install
them before proceeding with overlay installation (see
Chapter 3). If you do not have the synthesis tools installed, the
installation of TetraMAX overlay will not be allowed.

To perform overlay installation,

1. To download and install TetraMAX from the Web or by FTP, follow
the procedures described in “Downloading and Installing the
Software by EST” on page 2-2.

Or
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Install the files from the TetraMAX CD to your system, as
explained in “Installing Product Files From a CD” on page 2-6.
Example 2-1 on page 2-9 shows a Synopsys media installation
script for the synthesis tools. TetraMAX is installed in a similar
manner.

Note:

When you are prompted to select the product you want to
install, enter tx to perform an overlay installation.

2. Make sure your Synopsys license server and license key file are
set up to work with the synthesis tools. If you encounter
problems, see the SCL documentation, Licensing Quick Start
and Licensing Installation and Administration Guide.

Optional Installation of IddQTest

The IddQTest option of TetraMAX is installed separately from
TetraMAX ATPG and requires a special license.

To install IddQTest,

1. Run the same installation script again, but enter idq at the
“Product(s) Selected” prompt.

2. For the IddQTest target directory, specify the location where you
installed the TetraMAX overlay product.

Note:
The installation script does not allow you to install IddQTest into
a TetraMAX stand-alone installation.To create a stand-alone
installation of IddQTest, you must specify a completely separate
directory. Once you have done this, manually copy IddQTest into
the same directory as the TetraMAX stand-alone product.
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Setting Up the User Environment

To successfully invoke TetraMAX, you must define a separate
environment variable, SYNOPSYS_TMAX, and set the path to the
directory where TetraMAX ATPG is installed.

Perform one of the following procedures for the UNIX version of
TetraMAX. Note that these examples are for the C shell. Setups in
other shells will differ.

• To set up the user environment by using an alias, enter

% setenv SYNOPSYS_TMAX $SYNOPSYS
% alias tmax ’$SYNOPSYS_TMAX/bin/tmax \!*’

• To set up the user environment by using a path, enter

% setenv SYNOPSYS_TMAX $SYNOPSYS
% set path=($SYNOPSYS_TMAX/bin $path)

• To set up the user environment for using SoCBIST, enter

% setenv SYNOPSYS_TMAX $SYNOPSYS
% set path=($SYNOPSYS_TMAX/bin $SYNOPSYS/platform/syn/bin $path)

Replace platform with the required platform.
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Verifying the TetraMAX Installation

To verify installation of the TetraMAX tools,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the TetraMAX GUI by entering the following command on
a licensed machine:

% $SYNOPSYS_TMAX/bin/tmax

If the GUI appears, the installation was successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up TimeMill for Each User

• Verifying the TimeMill Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).
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Installing the Software

To download and install TimeMill from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the TimeMill software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. TimeMill is installed in a similar
manner. The TimeMill subtools (ADFMI, turboWave, and VTRAN)
are automatically installed with the TimeMill installation.

TimeMill can be installed as a stand-alone installation or with any of
the tools (NanoSim and TimeMill) it comes packaged with.

Setting Up TimeMill for Each User

To set up a new TimeMill tool user,

• If you are using the C shell, source the CSHRC_platform file
located in the install directory.

% cd install dir
% source CSHRC_platform

The install script for TimeMill creates a CSHRC_platform file for
each platform installed. The term platform is replaced with the
platform you installed.

The CSHRC_platform file contains the line

set path=(/install_directory/platform/ns/bin $path)
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where install_directory is the directory where the tool has been
installed.

If you don’t source the CSHRC_platform file, copy the above line
and set the path from that file.

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile, .kshrc, or .bashrc file:

PATH=/install_directory/platform/ns/bin:$PATH
export PATH

Replace platform with the appropriate platform (see “Products
and Supported Platforms” on page 1-6).

Verifying the TimeMill Installation

To verify the TimeMill installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% timemill

If you see information about the product version, production date,
and copyright, the installation was successful.
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This chapter contains the following sections:

• Installing the Software

• Setting Up VCS for Each User

• Verifying the VCS and VCSi Installation

• Customer Support

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).
21-1



• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

The instructions in this chapter also apply to VCSi.

Installing the Software

To download and install VCS from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the VCS software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6.

VCS is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of VCS. You
must create a new directory for VCS.

Setting Up VCS for Each User

To set up a new VCS tool user, add the VCS directory containing the
executable file to the PATH environment variable.

1. Set the VCS_HOME environment variable to the installation
directory. For example,

% setenv VCS_HOME /u/edatools/vcs7.0

2. Update your PATH environment variable as follows:

% set path=($VCS_HOME/bin/$VCS_HOME/‘$VCS_HOME/bin/vcs -location‘/  \
bin/$VCS_HOME/‘$VCS_HOME/bin/vcs -location‘/util $path)
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3. Set the LM_LICENSE_FILE or SNPSLMD_LICENSE_FILE
environment variable to point to the license file. For example,

% setenv LM_LICENSE_FILE /u/edatools/vcs7.0/license.dat

or

% setenv SNPSLMD_LICENSE_FILE 27000@my_server

Verifying the VCS and VCSi Installation

To verify the VCS and VCSi installation,

1. Make sure you are in a directory where you have read/write
privileges.

% cd $HOME

2. Invoke the tool by entering

% $VCS_HOME/bin/vcs -ID

If you see information about the product version, production date,
and copyright, the installation was successful.

3. Run the VCS GUI on each installed platform by entering

% $VCS_HOME/bin/vcs -RPP

Note:

The VCS GUI is available on both 32-and 64-bit platforms
(sparcOS5 or hp32).

4. Exit the GUI by choosing File > Exit in any GUI window.
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Customer Support

The VCS support page on the Synopsys World Wide Web site is
regularly updated with the latest information. Check this page for
application notes, online help updates, and other valuable
information:

http://www.synopsys.com/products/vcs

You can also send an e-mail message to VCS Support at
vcs_support@synopsys.com.
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This chapter contains the following sections:

• Downloading and Installing the Software

• Setting the Environment Variables

• Customer Support
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Downloading and Installing the Software

1. Create a Vera installation directory. For example,

% mkdir -p /usr/synopsys/vera

2. Download the Vera release to the installation directory. The latest
Vera download instructions can be obtained from the SolvNet
Release Library or from vera-support@synopsys.com.

If a Vera directory does not already exist, you must create one.

3. Uncompress and untar the files:

% pwd /usr/synopsys/vera

% gzip -dc  vera-version-platform.tar.gz

This will create a subdirectory under the Vera installation
directory. For example,

/usr/synopsys/vera/vera-version-platform

In the remainder of this chapter, this subdirectory is referred to as
the Vera installation directory.

4. To set the file permissions on the new directory tree and its
contents, enter

% chmod -R 755  /usr/synopsys/vera

5. Remove the vera-version-platform.tar.gz file:

% rm vera-version-platform.tar.gz

6. For each user, set the required environment variables. See
“Setting the Environment Variables” on page 22-3.
22-2

Chapter 22: Installing Vera (version 6.0.3)



Setting the Environment Variables

This section discusses the following environment variables:

• VERA_HOME

• SNPSLMD_LICENSE_FILE

• LM_LICENSE_FILE

It is recommended that you place these variables in your
$HOME/.cshrc or $HOME/.profile file as your default settings.

Setting the $VERA_HOME Environment Variable

1. Set the $VERA_HOME environment variable to point to your VERA
installation directory.

- If you are using the C shell, add the following line:

setenv VERA_HOME directory_path

- If you are using the Bourne shell, enter these lines:

VERA_HOME=directory_path
EXPORT VERA_HOME

2.  Add $VERA_HOME/bin to your search path:

- If you are using the C shell, enter

set path=($VERA_HOME/bin $path)

- If you are using the Bourne shell, enter

PATH=$VERA_HOME/bin:$PATH
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Setting the SNPSLMD_LICENSE_FILE or
LM_LICENSE_FILE Environment Variables

1. To enable Vera to check out a license,
set the SNPSLMD_LICENSE_FILE or the LM_LICENSE_FILE
environment variable.

- If you are using C shell, add the following line

setenv SNPSLMD_LICENSE_FILE port@hostname

- If you are using Bourne shell, enter these lines:

set SNPSLMD_LICENSE_FILE=port@hostname

export SNPSLMD_LICENSE_FILE

The port and host name variables correspond to the TCP port
and license server hostname specified in the SERVER line of the
Synopsys license file. To ensure better performance, it is
recommended that you use port@host rather than using the path
to the license file.

2. Each license file can contain licenses for many packages from
multiple vendors. You can specify multiple license files by
separating each entry with a colon (:).
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Customer Support

You can get support for Vera from the following locations:

• For technical Issues, enhancement requests, and feedback,
contact Customer Support at vera-support@synopsys.com.

• For documentation Issues, send e-mail to
vera-doc@synopsys.com

For general information on Synopsys licensing, see
http://solvnet.synopsys.com/keys.

For information on Vera licensing, see

• The Vera Installation Guide, which is packaged in Portable
Document Format (PDF) with the product files

• SolvNet article 900006, “VERA Licensing Structure,” at
http://solvnet.synopsys.com/retrieve/900006
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This chapter contains the following sections:

• Creating the Scirocco Root Directory

• Defining the SYNOPSYS_SIM Environment Variable

• Installing the Software

• Setting Up Scirocco for Each User

• Verifying the Scirocco Installation

To ensure a successful installation, complete the following
procedures before beginning the installation process:

• Create the Scirocco root directory (see page 23-2).
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• Define the SYNOPSYS_SIM environment variable, (see
page 23-2).

• Have your license server running and have the appropriate
license keys installed (see “Acquiring a License” on page 1-16).

Creating the Scirocco Root Directory

To create a new directory tree for this Synopsys release, enter

% mkdir -p /usr/SYNOPSYS_SIM/productversion/scirocco

To set the permissions on the new directory tree, enter

% chmod 755 /usr/SYNOPSYS_SIM/productversion/scirocco

Important:
Install each version of the software in a new directory. Do not
install different versions of Synopsys software in the same
directory.

Defining the SYNOPSYS_SIM Environment Variable

Set the SYNOPSYS_SIM environment variable in the shell that you
are using: C, Bourne, Korn, or Bash. Use the following commands,
in which the root_directory  argument is the name of the
Scirocco root directory.

• If you are using C shell, enter the following command to set the
SYNOPSYS environment variable:

% setenv SYNOPSYS_SIM root_directory
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• If you are using the Bourne, Korn, or Bash shell, enter the
following command to set the SYNOPSYS environment variable:

# SYNOPSYS_SIM=root_directory; export SYNOPSYS_SIM

Installing the Software

To download and install Scirocco from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To install the Scirocco software from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6. Example 2-2 on page 2-12 shows a Synopsys media
installation script for PrimeTime. Scirocco is installed in a similar
manner.

Scirocco is a stand-alone product and cannot be installed over an
existing Synopsys product, including a prior version of Scirocco. You
must create a new directory for Scirocco.
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Setting Up Scirocco for Each User

To set up a new Scirocco user, add the directory containing the
Scirocco executable files to the PATH environment variable.

• If you are using the C shell, add the following line to the .cshrc file:

set path=($SYNOPSYS_SIM/bin $path)

• If you are using the Bourne, Korn, or Bash shell, add the following
line to the .profile or .kshrc file:

PATH=(path:$SYNOPSYS_SIM/bin)

Verifying the Scirocco Installation

To verify Scirocco installation, enter

% $SYNOPSYS_SIM/admin/install/sim/bin/verify_install

If Scirocco is correctly installed, the system responds by printing the
following information and various copyright messages:

Info: Checking files in image
.....................................................................
................................
.....................................................................
....................
Info: Checking file permissions - passed
Info: Running Scirocco existence tests - passed
Verification of /snps/tools/2002.12/scirocco PASSED
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(version U-2003.03) 24

This chapter contains the following sections:

• About SOLD

• Acquiring and Installing the Acrobat Software

• Verifying Your Acrobat Software

• Installing SOLD

• Verifying the SOLD Installation

• Configuring SOLD for Each User

• Searching SOLD on Linux

To ensure a successful installation, complete the following
procedures before beginning the installation process:
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• Create the Synopsys root directory (see “Creating the Synopsys
Root Directory” on page 1-18).

• Define the SYNOPSYS environment variable (see “Defining the
SYNOPSYS Environment Variable” on page 1-19).

The U-2003.03 version of SOLD contains documentation for the
U-2003.03 release of Synopsys tools. You can access the
documentation by clicking the product name on the SOLD front
panel.

About SOLD

This chapter describes how to install and verify Synopsys Online
Documentation (SOLD). The SOLD CD and the SOLD directory
contain document files in the cross-platform Adobe Portable
Document Format (PDF), as well as Portable Document Index files
(PDX) that enable full-text searching across all SOLD documents.

To read and search these files, you need version 4.0 or later of
Adobe Acrobat Reader with Search plug-in or Adobe Acrobat. You
can download Acrobat Reader with Search plug-in free of charge
from the Adobe Web site. For more information, see “Acquiring and
Installing the Acrobat Software” on page 24-3.

The online documentation for CoCentric System Studio (CoCentric
System Studio SOLD) is distributed to CoCentric System Studio
customers on a separate CD. The installation instructions in this
chapter apply to both SOLD and CoCentric System Studio SOLD.
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Acquiring and Installing the Acrobat Software

You can acquire the Acrobat software in three ways:

• By downloading the freeware Acrobat Reader from the Web

• By installing the freeware Acrobat Reader from a CD

• By purchasing Adobe Acrobat

The following sections describe these options.

Downloading Acrobat Reader from the Web

To download Acrobat Reader from the Adobe Web site, go to
http://www.adobe.com/ and perform the following procedure. (The
details of these instructions might change if Adobe modifies its Web
site.)

1. Click the Get Acrobat Reader button.

2. On the Welcome page, click Get Acrobat Reader.

3. On the Acrobat Reader page, select the appropriate OS platform
under Step 1, and the Acrobat Reader features box under Step 2.

4. Click DOWNLOAD.

5. Select the “Save to Disk” option.

6. Uncompress the tar.Z or use the gunzip utility for the tar.gz file.
For example,

% gzip -d solaris-506.tar.gz

7. Untar the resulting file. For example,

% tar xvf solaris-506.tar
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8. Enter ./install to start the installation script.

For more information, consult the instguid.txt installation guide that
you get when you download Acrobat Reader.

Installing Acrobat Reader From a CD

If you do not have access to the World Wide Web, you can get a CD
containing Acrobat Reader software from your Synopsys sales
representative. You can also order the CD directly from Adobe for a
nominal fee.

To install Acrobat Reader from a CD,

1. Mount the Acrobat Reader CD.

2. Change the directory to the mount point of the CD-ROM. For
example,

% cd /cdrom

3. Change the directory to acroread/unix/Rdr_srch (ACROREAD/
UNIX/RDR_SRCH on the HP platform). For example,

% cd acroread/unix/Rdr_srch

Be sure to install the software from the Rdr_srch directory. Using
this directory ensures that the Search capability is enabled.

Note:

Acrobat doesn’t support the search capability for Linux, so you
will see a different directory if you are running Linux.

4. Enter ./install (or ./INSTALL for the HP platform) to start the
installation script.
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Using Adobe Acrobat

If you choose to purchase Adobe Acrobat (formerly called Acrobat
Exchange), install it by following the instructions in the product
documentation.

Adobe Acrobat allows you to alter PDF files in certain limited ways.
For example, you can add annotations and hypertext links to PDF
documents. With Acrobat Reader, you can view but not alter PDF
files.

Verifying Your Acrobat Software

To view SOLD, you must have Acrobat version 4.x or later.

To search SOLD, you must have the Search plug-in. For information
about searching SOLD on the Linux platform, see “Searching SOLD
on Linux” on page 24-11.

The following sections describe how to determine your current
software configuration.

Checking the Version Number

If you are using 3.x or an earlier version of Acrobat, you must
upgrade in order to view SOLD. Follow the instructions in “Acquiring
and Installing the Acrobat Software” on page 24-3.

To check the version number,

1. Open Acrobat Reader or Adobe Acrobat.
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2. Choose Help > About Acrobat Reader (or Help > About Adobe
Acrobat).

3. In the window that appears, verify that the words “Acrobat
Reader 4.0” or “Adobe Acrobat 4.0” appear. (Later versions of
Acrobat are also supported.)

4. Close the About screen by clicking anywhere in the window.

Checking for the Search Plug-In

If you are using Acrobat Reader without the Search plug-in, you must
upgrade in order to have full-text searching capability in SOLD. The
Search plug-in cannot be downloaded from the Adobe site as a
separate file; to upgrade, you must download the entire Acrobat
Reader with Search plug-in package. Follow the instructions in
“Acquiring and Installing the Acrobat Software” on page 24-3.

To check for the Search plug-in,

1. Open Acrobat Reader or Adobe Acrobat (if it is not already open).

2. Choose Help > About Plug-Ins to verify that Acrobat Search is on
the list of installed plug-ins.
24-6

Chapter 24: Installing Synopsys Online Documentation (version U-2003.03)



Installing SOLD

You can install SOLD by electronic software transfer (EST) or from
the SOLD CD.

Contents of SOLD

The SOLD documentation set contains PDF document files, the
index (PDX) files that enable full-text searching, and the UNIX
installation scripts.

SOLD contains several collections of documents. Each collection
describes a particular subject area and resides in its own directory.
Each collection directory contains all the PDF files for the books in
its subject area, as well as the index files for searching in that
collection.

The README.1ST file in the SOLD directory and on the SOLD CD
lists the contents of SOLD.

Installation Options

The SOLD installation procedure copies files from the SOLD
directory (for EST) or SOLD CD into the appropriate places in the
Synopsys root directory structure.

SOLD offers the following installation options:

• Full installation on hard drive

• Partial installation on hard drive

• No installation on hard drive (read from CD)
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The installation script performs a full installation. Most sites use a full
installation for shared access by many users. If disk space is at a
premium, you can create a partial installation by removing unused
directories after the installation is complete (see “Partial Installation”
on page 24-9).

Electronic Software Transfer Installation

To download and install SOLD from the Web or by FTP, follow the
procedures described in “Downloading and Installing the Software
by EST” on page 2-2.

To access the complete collections of SOLD, download CDs 1 and 2.
The SOLD files use the following convention:

sold_U-2003.03_ssd1.tar.Z
sold_U-2003.03_ssd2.tar.Z

Two additional SOLD CDs are available: one for the Japanese
version of SOLD and one specifically for CoCentric System Studio
customers.

If you want to download only J-SOLD, download the
sold_U-2003.03_jsd3.tar.Z file. To download only CoCentric System
Studio SOLD, download the sold_U-2003.03_ssd4.tar.Z file.

Example 2-1 on page 2-9 shows a Synopsys media installation
script for the synthesis tools. SOLD is installed in a similar manner.
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CD Installation

The SOLD collections are packaged in four tar files and each file is
on a separate CD. To install SOLD from the CD, follow the installation
procedure described in “Installing Product Files From a CD” on
page 2-6.

Untar and uncompress the SOLD files before running install.now.

To access the complete collections of SOLD, copy CDs 1 and 2 to
you hard disk. The SOLD files use the following convention:

sold_U-2003.03_ssd1.tar.Z
sold_U-2003.03_ssd2.tar.Z

Two additional SOLD CDs are available: one for the Japanese
version of SOLD and one specifically for CoCentric System Studio
customers.

If you want to install only J-SOLD, copy the
sold_U-2003.03_jsd3.tar.Z file. To install only CoCentric System
Studio SOLD, copy the sold_U-2003.03_ssd4.tar.Z file.

Example 2-1 on page 2-9 shows a Synopsys media installation
script for the synthesis tools. SOLD is installed in a similar manner.

Partial Installation

Because each collection directory is self-contained, partial
installations of SOLD are possible.

To effect a partial installation of SOLD, perform a standard
installation, then delete from $SYNOPSYS/doc/online those
collection directories you do not need at your site.
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Note:
Do not delete the top.pdf file; it contains the SOLD front panel,
which lists the products that are documented. Do not delete the
solid directory; it contains the SOLD User Guide.

Keep the remaining collection directories intact: Do not remove files
from them or move the files in a collection relative to each other.
Such modifications can cause hypertext links and the search
mechanism to fail.

Verifying the SOLD Installation

Verify the installation by opening SOLD. To open SOLD, issue the
command

% $SYNOPSYS/sold

If SOLD is correctly installed, this command invokes Acrobat and
displays the SOLD welcome screen in the Acrobat window.

Configuring SOLD for Each User

The search engine uses index files to perform full-text search and
retrieval on a document. SOLD provides an index file (index.pdx)
with each collection.

When you open a document, the associated index file is
automatically available to the search engine. However, to search
SOLD before opening a document, you can manually make an index
available to the search engine.
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To manually make an index available to the search engine,

1. Choose Edit > Search > Select Indexes in the Acrobat window.

2. Click the Add button.

3. Navigate to one of the collection directories, for example,
$SYNOPSYS/doc/online/synth.

4. Select the index.pdx file.

5. With the index.pdx file selected, click the Apply button.

The selected index is added to the list of available indexes.

For information about using SOLD, see the SOLD User Guide. To
access the SOLD User Guide, open SOLD and click the hypertext
link labeled “Using Synopsys Online Documentation.”

Searching SOLD on Linux

Only the Find command (Edit > Find) is available for searching the
Linux version of SOLD. To locate information with the Find
command, use the print version of a document. From the SOLD front
page, select a document set, then click the print version icon ( )
next to the document you want.
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Troubleshooting 25

This chapter contains the following sections:

• Memory

• X Window System
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Memory

Some common memory problems and possible solutions are
described in this section.

Why Do I Get an “out of memory” Message?

Here is a possible scenario: A large job is running on a machine that
has abundant swap space. You try to run a Design Compiler job on
this machine and assume that you don’t need to be concerned about
running out of swap space. But the application terminates with a fatal
out-of-memory message before the machine runs out of swap
space.

UNIX limits the amount of memory a job or process can consume
while it is running. If a job reaches these limits before the system
runs out of swap space, the job terminates with the fatal
out-of-memory error message. These limits are built into the UNIX
OS to prevent a single job or process from consuming all system
resources (swap space, CPU time, number of processes, and so on),
thereby depleting resources for other jobs. Some limits applicable to
Synopsys applications are

• Data size—The maximum data size (including stack) for the
process

• CPU time—The maximum CPU seconds per process

• Core dump size—The maximum size of a core dump

The data-size limit is the most important. It can be set at two levels:

• The system level
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Limits are enforced for everyone who runs on that system.

• On a per-user basis

On all machines except those running HP-UX, you can change
your personal limits by using the limit command (C shell) or
ulimit -s -d command (Bourne, Korn, or Bash shell). On the
HP-UX platform, only the system administrator can set the limits.
Personal limits cannot exceed the systemwide limit. For example,
the limits on a Sun client (Solaris 7) might look like this:

% limit
cputime          unlimited
filesize         unlimited
datasize         524280 kbytes
stacksize        8192 kbytes
coredumpsize     unlimited
descriptors      256
memorysize       unlimited

Note:

In this example, any jobs or processes started on the Sun
client can grow to 524 MB before limits are enforced.

On some solaris systems, setting the data size to unlimited
defaults to a data size of only 2 GB. To set a larger data size,
set the data size explicitly. For example, set it to 3.8 GB by
using the following command:

% limit datasize 3891 MB

If the data size is sufficient, check the stack size. A stack size that is
larger than the default (8,192 KB) can cause the data size to be
smaller than required. Because the stack size is taken at the
beginning of the process, it uses memory that would normally be
available for data. Therefore you should set the stack size higher
than the default only when absolutely necessary.
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Most system administrators do not adjust the limits unless they are
confronted with problems. If you do not adjust the limits, it is possible
for a tool requiring a lot of swap space (such as Design Compiler) to
experience an out-of-memory problem.

Note, however, that it is possible to extend memory (physical and
swap space). For more information, see “Accessing Memory Beyond
2 GB With 32-Bit Synopsys Tools” on page 1-13.

What Should I Do When an “out of memory” Error
Occurs?

Make sure that you are not running out of swap space on the system.
Use the swap -l command for Sun SPARC systems to obtain swap
space information. For example,

  % swap -l
  swapfile           dev   swaplo  blocks   free
  /dev/dsk/c0t3d0s1  32,25      8  822520   628872

To determine available swap space on systems other than Sun
SPARC, contact your system administrator.

If you have enough swap space but still encounter OS limits, use the
limit command to find out what the datasize variable is set to
(for all machines except HP). The limit command displays
user-level limits.

% limit
cputime          unlimited
filesize         unlimited
datasize         524280 kbytes
stacksize        8192 kbytes
coredumpsize     unlimited
descriptors      256
memorysize       unlimited
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If your user-level data-size limit is too low, you can increase it by
entering limit datasize xxxxm at the UNIX prompt, where xxxx
is the number of megabytes and m stands for megabytes. For
example,

% limit datasize 3891m

Note:
The limit command is a built-in C shell (csh) command. Make
sure you are in csh before you execute limit.

For additional information about the limit command, see the
appropriate man page. On HP systems you cannot change the
user-level limits. User-level limits can be changed only at the system
level.

The procedure for making limit changes varies from platform to
platform. The system administrator at each site should be familiar
with the procedure. If you still encounter problems, contact your
ncuSynopsys technical representative.

X Window System

Some common X Window System problems and possible solutions
are the following:

• If you cannot use the vi text editor in the xterm window, add an
xterm entry in your /etc/termcap file.

• If, after an upgrade, you can no longer open Design Analyzer
from your host, verify that the fonts assigned in
.synopsys_dc.setup or the server default fonts are loaded. A fatal
error results if the fonts are not available.
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• Your ~/.xinitrc script might not be read on startup because it is a
C shell script. In this case, you must rewrite it as a Bourne (/bin/
sh) script.
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Part II: Placement and Routing Tools
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Installing Astro, Columbia, and JupiterXT
(U-2003.03) 26

Note:
The installation instructions in this chapter are the most
up-to-date available at the time of production. However, changes
might have occurred. For the latest installation information, see
the product release notes or documentation.

This chapter contains the following sections:

• Media Availability and Supported Platforms

• Installing the Software

• Setting Up Astro for a New User

• Verifying the Astro Installation
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Media Availability and Supported Platforms

Astro is available on CD or by FTP download. Obtain the appropriate
binary executable files based on the operating system you need. The
U-2003.03 release supports the following platforms:

Installing the Software

The steps in this procedure describe how to install Astro on the Sun
Solaris 32-bit platform. For other platforms, use the appropriate file
name and platform for the tool you want to install.

To install the Astro software on your server,

1. Change directory to the install directory,

% cd install_dir

where install_dir is the directory where you want to install the
software.

2. Begin the installation:

% ls /cdrom/volume_name/3.5.0.3.astro.sun.32.tar.gz

The volume_name file name might vary, depending on your
workstation. Check the title bar of the pop-up File Manager
window for the accurate volume name.

Operating System Platform keyword

Solaris 8 sun.32, sun.64

HP-UX 11.0, 11i hp.32, hp.64

Red Hat Linux 7.2 ia.32
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3. Examine the contents of your directory:

% ls /cdrom/volume_name

You should see the following file:

% /cdrom/volume_name/3.5.0.3.astro.sun.32.tar.gz

4. Unzip the file:

% gzip -dc /cdrom/volume_name/3.5.0.3.astro.sun.32.tar.gz | tar  -vxf -

5. Change to the bin directory:

% cd bin/SUN.32

6. Copy the Synopsys license daemon to the /etc directory:

% cp -p avantd /etc

7. Create a license directory:

% mkdir /usr/local/flexlm /usr/local/flexlm/licenses

8. Copy the license to the license directory:

% cp source_dir/license.dat /usr/local/flexlm/licenses

where source_dir is where the license.dat (and package.dat) file
resides.

9. Start the license server:

% lmgrd -c /usr/local/flexlm/licenses/license.dat  -l  /usr/local/flexlm/  \
   licenses/license.log

10. To automatically start the license server whenever you reboot the
server, add the following line to the /etc/rc.local file,

install_dir/bin/SUN.32/lmgrd -c /usr/local/flexlm/licenses/license.dat -l / \
   usr/local/flexlm/licenses/license.log

where install_dir is the directory where you installed the software.
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For more information about the license server, see
www.synopsys.com/keys or the FLEXlm user guide.

Note:

Beginning with the Astro U-2003.03 release, the online Help is
included with the release image. There is no longer a separate
tar.gz file for online Help.

Setting Up Astro for a New User

This section describes how to set up local machines for Solaris so
that it can access the Synopsys software. Perform this procedure for
each machine on the network.

1. To set up your machine, update your environment variables by
adding one of the following groups of variables in your .cshrc file.

setenv LM_LICENSE_FILE /usr/local/flexlm/licenses \
/license.dat:$LM_LICENSE_FILE

set path = (install_dir/bin/$platform $path)

where install_dir is the directory in which the Synopsys software
is installed and platform is the appropriate platform.

2. Update your path variable by entering the following from the
UNIX prompt:

% source .cshrc

Make sure the XKeysymDB file resides in or is linked from /usr/
lib/X11.
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Verifying the Astro Installation

To verify the Astro installation,

1. Make sure you are in a directory where you have read/write
privileges:

% cd $HOME

2. Invoke the tool by entering the following command:

% Astro

If you see information about the product version, production date,
and copyright, the installation was successful.
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Installing HSPICE (version U-2003.03) 27

Note:
The installation instructions in this chapter are the most up-to-
date available at the time of production. However, changes might
have occurred. For the latest installation information, see the
product release notes or documentation.

This chapter includes the following sections:

• Media Availability and Supported Platforms

• Installing the Software on UNIX or Linux Platforms

• Configuring HSPICE and AvanWaves for UNIX and Linux

• Setting Up HPICE and AvanWaves for Each User

• Verifying the HSPICE and AvanWaves Installation

• Installing the Software on Windows Platforms
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• Troubleshooting

• Customer Support

Media Availability and Supported Platforms

HSPICE is available on CD or by FTP download. Obtain the
appropriate binary executable files for your operating system.
Table 27-1 lists the supported platforms for this release.

The supported platforms and platform keywords for the binary files
you need are as follows:

• sun55 executable files support Sun Solaris 2.5.1, or 7 (sparc).

• pa10_awaves executable files can be executed on HP-UX 10.20
or HP-UX 11.00.

Table 27-1 Products and Supported Platforms

Sun Solaris
2.5, 7,8

HP-PA
HP-UX
10.20, 11.0

IBM RS/6000
AIX 4.3

Red Hat
Linux 6.2,
7.2

DEC
Alpha
OSF 4.0

Windows
NT,2000,
XP

HSPICE CD
FTP

CD
FTP

CD
FTP

CD
FTP

CD
FTP

CD
FTP

Interface CD
FTP

CD
FTP

CD
FTP

N/A1

1. Not available.

N/A N/A

AvanWaves CD
FTP

CD
FTP

CD
FTP

CD
FTP

N/A CD
FTP

Metaencrypt CD
FTP

CD
FTP

CD
FTP

CD
FTP

CD
FTP

CD
FTP
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Note:
When you use HSPICE with Windows platforms using AMD
Athlon CPUs, only a single processor is supported.

Installing the Software on UNIX or Linux Platforms

To install HSPICE and AvanWaves from the CD,

Note:
If you have problems reading the CD on the Solaris 7 platform,
contact Sun to obtain OS patch version 107465-04 or later
(/kernel/fs/hsfs/patch).

1. Make sure you have enough disk space for HSPICE and
AvanWaves installation. For a full installation on one platform,
120 MB is recommended.

2. To load the software, enter

% path_to_cdrom/install_dir/synopsys_install

The Synopsys Installation Program dialog box appears.

3. Enter the name of the installation directory in which you want to
load the products.

4. Select the products and platforms that you want to load, and then
click Load.

5. After the loading is completed, click Exit.
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To install HSPICE and AvanWaves by electronic software transfer,

1. If necessary, create an HSPICE installation directory. For
example,

% mkdir -p /usr/synopsys/hspice

2. Change to the HSPICE installation directory:

% cd/usr/synopsys/hspice

3. Download the HSPICE binary files to the installation directory.

You can get the latest HSPICE download instructions from the
SolvNet Release Library.

4. Uncompress and untar the files.

% pwd /usr/synopsys/hspice
% gzip -dc  hspice-version-platform.tar.gz

Note:

This will create a subdirectory under the HSPICE installation
directory. For example,

/usr/synopsys/hspice/version

In the remainder of this chapter, this subdirectory is referred to
as the installation directory or $installdir.

5. To set the file permissions on the new directory tree and its
contents, enter

% chmod -R 755  /usr/synopsys/hspice

6. Remove the hspice-version-platform.tar.gz file.

% rm hspice-version-platform.tar.gz

7. Configure HSPICE and AvanWaves for your site.
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8. Verify the HSPICE and AvanWaves Installations.

9. For each user, set the required environment variables.

To configure the tools, verify the installations, and set the
environment variables for each user, see the following sections.

Configuring HSPICE and AvanWaves for UNIX and
Linux

This section describes how to set up and configure the HSPICE and
AvanWaves products after loading them from the CD.

To configure the products for UNIX and Linux platforms,

1. Verify the platform on which you want to configure the products.

2. Invoke the configuration program by entering

% installation_directory/bin/config

The Configure Products dialog box appears.

3. If you want to configure AvanWaves, select Configure
AvanWaves. No option is required.

4. If you want to configure HSPICE, select Configure HSPICE. The
configuration options are “versions file...,” “meta.cfg file ...,”
“hspice.ini file ...,” and setup buttons. If you do not select these
options, the default settings apply.

5. After selecting your options, click the Configure button. The
configuration log is shown in the middle of the dialog box.

6. Click Exit when the configuration has finished.
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Setting Up HPICE and AvanWaves for Each User

To set up a new tool user,

• Source the .cshrc.meta or . kshrc.meta file

• Enter the path information

• Set up a license variable that points to the license server

Add the following information to the .cshrc, .kshrc, or an HSPICE
source file:

1. Add the HSPICE and AvanWaves executable files to your search
path.

- If you are using C shell, enter

set path=(installation_directory/bin $path)

- If you are using Bourne shell, enter

PATH=installation_directory/bin:$PATH

2. Set one of the following licensing variables:

AVANTD_LICENSE_FILE

or

LM_LICENSE_FILE

3. Source the cshrc.meta or .kshrc.meta file.

- For C shell users, enter

% source installation_directory/bin/cshrc.meta

- For Korn shell users, enter

$ . installation_directory/bin/kshrc.meta
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Verifying the HSPICE and AvanWaves Installation

After you set up the licensing and HSPICE software packages, do
the following:

• For C shell users, enter

% source installation_directory/bin/cshrc.meta

• For Korn shell users, enter

$ . installation_directory/bin/kshrc.meta

If this step fails, or if the cshrc.meta file does not exist, the installation
program failed. To find the problem, review the installation logfile:

% installation_directory/bin/synopsys_config.log_pid

Verifying the HSPICE Installation

To verify the HSPICE installation, follow these steps:

1. Enter

% cd $installdir/demo/hspice/bench

The $installdir environment variable specifies the path to
the directory where the HSPICE products are installed.

2. To run a demo simulation, enter

 % hspice demo.sp > demo.lis

3. To view the simulation output, enter

% vi demo.lis
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4. If you are able to get a license, you will see a message about
licenses near the top of the listing.

lic: Checkout hspice; Encryption code: xxx

If you get a ***** job concluded statement near the bottom of the
listing, the simulation was successful.

Verifying the AvanWaves Installation

    To verify the AvanWaves installation,

1. Change to the installation directory.

% cd $installdir/bin/

The $installdir environment variable refers to the HSPICE
installation directory. This variable is created when you source
cshrc.meta.

2. To start AvanWaves, enter

% awaves &

Installing the Software on Windows Platforms

This section describes how to install and set up the license server for
HSPICE on a PC. To run HSPICE, your system must have

• A Pentium or compatible processor or higher.

• At least 32 MB of memory (64 MB or more is recommended)

• A parallel port for the security key

• Windows NT, Windows 2000, or Windows XP operating system
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• Approximately 100 MB of free disk space for a full installation of
HSPICE, AvanWaves, and MetaEncrypt

Installing With Windows Explorer

To install HSPICE by using Windows Explorer,

1. Insert the HSPICE CD into the CD drive.

2. In Windows Explorer, double-click the CD drive icon.

3. Double-click the pchspice folder icon.

4. Double-click the Setup application icon.

5. To install the software, follow the screen prompts.

Installing With Windows DOS Shell

To install HSPICE by using the Windows DOS shell,

1. Insert the HSPICE CD into the CD drive.

2. At the DOS shell command prompt, enter

% CD-ROM drive letter:\pchspice\setup.exe

3. To install the software, follow the screen prompts.
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Installing the Sentinel System Drivers

For information about the Win32 sentinel_key driver (dongle key),
see the README.txt file located in the %installdir% installation
directory.

1. Enter

$installdir\DRIVERS and execute flexid.exe to install the Win32

2.  Set the LM_LICENSE_FILE environment variable.

% /path_to_license_file

For additional information about the FLEXlm licensing, see the
FLEXlm End User Manual.

Running HSPICE

You can run HSPICE in any of the following ways:

• Double-click the HSPUI icon and then click the Simulate button.

• Double-click the HSPICE icon. You are prompted to enter names
for the input netlist file and output list files. If you do not name an
output file, all of the .lis, .st0, and .tr0 files will be written in the
directory in which you run HSPICE or hspice.exe.

• From the DOS prompt in Windows, enter

%installdir%\BIN\HSPICE -i netlist -o listfile {-b}

Note:
Make sure you have set the environment variable correctly before
running circuit.
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Running AvanWaves

Start AvanWaves in any of the following ways:

• Double-click the HSPUI icon and then click the AvanWaves
button.

• Double-click the AvanWaves icon.

• From the DOS prompt in Windows, enter

%installdir%\BIN\AWAVES

Important:
If you start AvanWaves by using a method other than selecting
the HSPUI icon and then you open online Help, you must delete
the Galaxy Help Server task from the Task List after you exit
AvanWaves. Otherwise the next invocation of HSPICE can have
a memory conflict with the AvanWaves Galaxy Help server.

Running Older Versions of HSPICE

You can use the HSPUI utilities to run different versions of HSPICE
that are already installed on your computer. Under the installation
directory (%installdir%), the versions.txt file contains all the
information about different versions of HSPICE.

An example of a versions.txt file follows:

<BOF>
  c:\avanti\Hspice2001.2\BIN\hspice.exe    HSPICE 2001.2
  c:\avanti\Hspice2002.2\BIN\hspice_mt.exe HSPICE 2002.2
<EOF>
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You can add different HSPICE executable file full paths to
subsequent lines in the versions.txt file. The second column contains
comments as a version reminder and is ignored by the HSPUI utility.
After HSPUI is invoked, you can select the HSPICE version in the
combo box of the HSPUI window. HSPICE will run according to the
path selected in the combo box.

The following executable files are provided on the HSPICE,
AvanWaves, and Utility disks:

*.EXE File
%installdir%\bin\lmutil (lmutil hostid - sentinel; run from the DOS
prompt)
\%installdir%\bin\hspice (HSPICE executable running in a PC Windows
environment)
%installdir%\bin\awaves (AvanWaves executables running in a PC Windows
environment)
%installdir%\bin\hspui (GUI utility that launches HSPICE.EXE and
AWAVES.EXE)

The hspice.ini File on Windows Platforms

The hspice.ini file is the configuration file that contains HSPICE
options. For example,

.Option Post =1

.Op

.Option Post_version = 9601

..................

If you have installed more than one version of HSPICE on the same
PC, more than one hspice.ini file will exist but only one will take
effect.

To find the hspice.ini file, on Windows NT, 2000, or XP platforms, look
in the meta.cfg file, which HSPICE reads into the installdir
system environment variable.
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Troubleshooting

• If you have multiple dongles connected to each other, the
Windows dongle must be connected directly to the PC.

• If you are a Novell Network user, be aware that it is common for
Novell Networks to have search drives replace the standard path
set in the autoexec.bat file, which might cause HSPICE to fail to
locate the executable file.

See your Novell system administrator to get an additional search
drive that points to the installation directory.

Customer Support

 For documentation about using HSPICE and AvanWaves, see the

• AvanWaves User Guide

• Device Models Quick Reference Guide

• Elements and Device Models Manual

• HSPICE Applications Manual

• HSPICE Quick Reference Guide

• HSPICE Signal Integrity Guide

• HSPICE Simulation and Analysis User Guide

• MOSFET Models Manual

All documentation is available on SOLD or through Documentation
on the Web. Print versions are available only for the HSPICE Quick
Reference Guide and Device Models Quick Reference Guide.
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For information about accessing HSPICE documentation, see
“Related Publications” on page xvii.

For information about contacting Customer Support, see “Customer
Support” on page xix.

If you cannot solve a problem, use an editor to review the following
files for system error messages:

• /tmp/pid/synopsys_install.log_pid (which is generated during
installation)

• /tmp/pid//synopsys_config.log_pid (which is generated during
configuration)
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Note:
The installation instructions in this chapter are the most up-to-
date available at the time of production. However, changes might
have occurred. For the latest installation information, see the
product release notes or documentation.

This chapter includes the following sections:

• Media Availability and Supported Platforms

• Installing the Software

• Setting Up Star-RCXT for Each User

• Verifying the Star-RCXT Installation

• Customer Support
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Media Availability and Supported Platforms

Star-RCXT is available on CD or by FTP download. Obtain the
appropriate binary executable files based on the operating system
you need. The U-2003.03 release supports the following platforms:

Installing the Software

To install Star-RCXT from the CD,

1. To load the software, enter

% path_to_cdrom/install_dir/synopsys_install

The Synopsys Installation Program dialogue box appears.

2. Enter the name of the installation directory in which you want to
load the products.

3. Select the products and platforms that you want to load, and then
click Load.

4. After the loading is completed, click Exit.

To install Star-RCXT by electronic software transfer,

Operating System Platform keyword

Solaris 5.6 Sun5_6

Solaris 5.7+ Sun64-57

HP-UX B.10.20+ HP160

HP-UX B.11.00+ HP6452

Red Hat 7.2+ I386-L24
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1. Create a Star-RCXT installation directory. For example,

% mkdir -p /usr/synopsys/star-rcxt/version

2. Change to the Star-RCXT installation directory:

% cd/usr/synopsys/star-rcxt/version

3. Download the Star-RCXT binary files to the installation directory:

You can get the latest Star-RCXT download instructions from the
SolvNet Release Library.

4. Uncompress and untar the files. For example

% gzip -dc platform_star-rcxt-version.tar.gz | tar xvf -

Substitute the appropriate platform keyword for platform. (See
“Media Availability and Supported Platforms” on page 28-2.)

Note:

This will create a subdirectory under the Star-RCXT
installation directory. For example,

/usr/synopsys/star-rcxt/version

In the remainder of this chapter, this subdirectory is referred to
as the installation directory or $installdir.

5. To set the file permissions on the new directory tree and its
contents, enter

% chmod -R 755  /usr/synopsys/star-rcxt

6. Remove the star-rcxt-version-platform.tar.gz file

% rm star-rcxt-version-platform.tar.gz
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Setting Up Star-RCXT for Each User

To set up a new tool user, each user must,

• source .cshrc.meta or . kshrc.meta

• Enter the path information

• Set up a license variable that points to the license server

It is recommended that the following information be added to
the.cshrc, .kshrc, or an Star-RCXT source file:

1. Add the Star-RCXT executable files to your search path:

- If you are using C shell,

set path=(installation_directory/bin $path)

- If you are using Bourne shell,

PATH=installation_directory/bin:$PATH

2. Set the following licensing variable:

LM_LICENSE_FILE
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Verifying the Star-RCXT Installation

To verify the Star-RCXT installation,

1. Make sure you are in a directory with read/write privileges.

% cd $HOME

2. Run the Star-RCXT GUI on each installed platform by entering
the following command:

% StarXtract -gui

The GUI will appear on your screen.

3. Exit the GUI by choosing File > Exit in any GUI window.

Customer Support

For information about using Star-RCXT, see the Star-RCXT User
Guide.

For information about accessing Star-RCXT documentation, see
“Related Publications” on page xvii.

For information about contacting Customer Support, see “Customer
Support” on page xix.
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Installing TCAD Products and Utilities 29

This chapter describes the procedures for installing Synopsys TCAD
products on UNIX systems.

Note:
The installation instructions in this chapter are the most
up-to-date available at the time of production. However, changes
might have occurred. For the latest installation information, see
the product release notes or documentation.

This chapter includes the following sections:

• Media Availability and Supported Platforms

• Installing TCAD Products

• Installing the TCAD Network License Software

• Running TCAD Products
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• Using the TCAD Network License System and Software

• Troubleshooting

• TCAD Utilities

Media Availability and Supported Platforms

For the U-2003.03 release, the Aurora, Raphael, and Raphael NES
TCAD products are available on CD or by FTP download. Obtain the
appropriate binary executable files for your operating system.
Table 29-1 lists the supported platforms for this release.

Installing TCAD Products

The general procedure for installing a TCAD product consists of the
following steps:

1. Obtain a SolvNet account.

2. Download TCAD software or request CD media.

3. Establish a TCAD directory.

Table 29-1 Products and Supported Platforms

Product Operating system Platform keyword

TCAD, Aurora,
Raphael, Raphael NES

IBM R/S6000 AIX 4.3.3 aix43

DEC ALPHA Digital UNIX 4.0 dec

HP-UX 11.00 hpux

Sun Solaris 8 sparcOS5 (32-bit platforms)
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4. Run the product installation script.

5. Create the license.dat file in the license directory and start the
license daemon.

Steps 1 through 4 are discussed in this section. Step 5 is discussed
in “Using the TCAD Network License System and Software” on
page 29-29.

Obtaining a SolvNet Account

SolvNet is the online gateway to Synopsys service and support.
Through SolvNet, customers can retrieve software, request media,
retrieve license files, and view online documentation.

If you do not have a SolvNet account, register for an account by
visiting the SolvNet Web site (http://solvnet.synopsys.com) and
clicking the Register Today link.

Note:
To access all Synopsys online services in SolvNet, you need to
register with a valid Synopsys site ID.

Downloading TCAD Software or Requesting CD Media

After establishing a SolvNet account using your site’s Synopsys site
ID, you can download the TCAD software from the Synopsys
electronic software transfer system (ftp) or request CD media.

To download the software, follow these steps:

1. Go to ftp.synopsys.com.

% ftp ftp.synopsys.com
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2. When prompted for a name and password, enter your SolvNet
login name and password.

3. At the ftp prompt, set the transfer mode to binary.

ftp> binary

4. Change directory to the revenue vault.

ftp> cd /rev

5. Change directory to the appropriate product directory (for
example, a_tcad-medici_version).

ftp> cd <product>

6. List the directory contents.

ftp> dir

7. For each file that you want (for example,
tcad-medici_version_platform.install), retrieve the file by using
the get command.

% get <filename>
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8. After retrieving the product files, quit the ftp session.

ftp> quit

To request CD media,

• Log on to the SolvNet Web site (http://solvnet.synopsys.com)
and click the MediaDocs link.

Note:

Because of contract restrictions, only certain sites are
authorized to order CD media. If you are not sure about your
site’s eligibility, contact your Synopsys account manager.

Establishing a TCAD Directory Tree

If a TCAD product has previously been installed on your system, a
TCAD directory with a name such as /usr/tcad or /usr/myaccount/
tcad should already exist. If you are uncertain about its name,
contact your system administrator for assistance.

If a TCAD directory does not exist, decide where to store the TCAD
products on your system. Consult Table 29-2 to determine the
approximate disk space required for the products you need. Make
sure you select a location with sufficient disk space to install these
products and allow room for future installations.

Table 29-2 TCAD Disk Requirements

Product Disk (MB)

Aurora 165

Davinci 125

Medici 135
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Running the Installation Script

If you are installing from a file retrieved from the FTP site, make sure
the file has the correct file permissions:

% chmod 755 <product script>

If you are installing from CD, mount the CD and change directory to
the CD drive. Contact your system administrator if you require
assistance in mounting the CD. Next you must run the installation
script:

% ./<product script>

The <product script> creates the appropriate directories and installs
the product. During execution of a program installation script, several
actions take place, and some require you to respond to prompts.

Raphael 85

Raphael NES 75

Taurus Layout 20

Taurus Process/Device 140

Taurus Visual 125

Taurus WorkBench 355

TSUPREM-4 100

Table 29-2 TCAD Disk Requirements (Continued)

Product Disk (MB)
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1. The installation script prompts you for your TCAD directory.
Enter the full path to your TCAD directory. The installation script
then extracts the product into your TCAD directory.

2. Upon successful completion of the installation, the script displays
a summary. A copy of this summary, as well as a log of your
responses to the system prompts, is located in the
install_<program>.log file in the program directory.

Caution!
You must add the tcad/bin directory to your search path if it is not
already there. For example, if your TCAD directory is /usr/
myaccount/tcad, your search path must include /usr/myaccount/
tcad/bin. For details, see “Setting Up Your Search Path” on
page 29-8.

After the installation is completed, the directory tree shown in
Table 29-3 exists as subdirectories of the TCAD directory:

Table 29-3 TCAD Directory Tree

Subdirectory Contents

bin/ Contains links to the TCAD executable files.

<program>_<version>/ Contains the TCAD product files and directories,
including the install_<program> product installation
script.

utility/ Contains various utilities for use with TCAD
products. See the “TCAD utility Directory” on
page 29-38 for a discussion of the contents of the
utility directory.

license/ Contains the TCAD Network License Software and
the license.dat license data file.

license_tma/ Contains the TCAD Network License Software for
all supported platforms in compressed tar format.
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Setting Up Your Search Path

A search path is a list of directory paths. The system searches
through directories to find an executable file. Each TCAD product
user must have a search path that contains the TCAD bin directory.
This section explains how to set up your search path so that you can
run a TCAD product from any directory.

Checking Your Search Path

If a TCAD product has already been installed on your system with the
installation script, the TCAD bin directory might already exist in your
search path. To determine whether it does, enter

% which <program>

where <program> is a TCAD executable file such as medici, raphael,
or taurus.

If you get a response similar to

/usr/myaccount/tcad/bin/<program>

your search path is set correctly.

If you get a response similar to

no <program> in /bin /usr/bin /usr/local/bin

you must modify your search path as described in the following
section.
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Modifying Your Search Path

Your search path is defined by the PATH environment variable.
Determine your current search path by entering

% echo $PATH

Note:
PATH must be entered in uppercase letters.

This is an example of a search path:

.:/bin:/usr/bin:/usr/local/bin

Modifying Your Path in the C shell

The following example illustrates the commands used to modify your
path. In this example, the TCAD directory on your system is named
/usr/myaccount/tcad.

• To permanently add this directory to your search path, add the
following line to your $HOME/.profile.

set path=(/usr/myaccount/tcad/bin $path)

Save your changes.

• Enter the following command:

% source .cshrc

Modifying Your Path Under the Bourne or Korn Shell

To modify your path you must use specific commands. In this
example, the TCAD directory on your system is named /usr/
myaccount/tcad.
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• To permanently add this directory to your search path, add the
following line to your $HOME/.profile or $HOME/.kshrc file:

PATH=/usr/myaccount/tcad/bin:$PATH
export PATH

Save your changes.

• Enter one of the following commands:

$ . profile

or

$ . kshrc

Installing the TCAD Network License Software

The TCAD Network License Software is automatically loaded by the
installation script.

Note:
To install TCAD license keys formatted for Synopsys licensing,
you must have version 5.12 or later of the tmald daemon. You
can check the version number by entering tmald -v. Version
5.12 of the tmald daemon is not available separately—it is
included with the latest TCAD products. The products also
include lmgrd and lm utilities. To download the latest license
keys, click the Smartkeys link in SolvNet or go to
www.synopsys.com/smartkeys. A SolvNet user name and
password, as well as your Synopsys site ID, are required.
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This section describes the basic procedure for completing the
installation of the TCAD Network License Software on your UNIX
computer.

1. Move to the license directory:

% cd <name of TCAD directory>/license

2. Modify the keyfile you received through e-mail (from SmartKeys)
to remove all extraneous text.

a. Save the e-mail message in a file named license.dat in the
license directory in the TCAD directory.

b. Use a text editor to edit this file and remove the mail header
information and any blank lines. All comment lines must begin
with # and cannot wrap to the next line.

The license.dat file should contain only lines that begin with
SERVER, #,  DAEMON, INCREMENT, PACKAGE, and
FEATURE.

3. Modify the SERVER and DAEMON lines:

a. Replace the hostname1 field with your license server’s
machine name (determined by the UNIX hostname
command).

SERVER my_server 87654321 27000

b. Modify the DAEMON line so that it contains the full path to the
tmald daemon.

DAEMON tmald/usr/myaccount/tcad/license/tmald

c. (Optional) Change the default TCP port number (at the end of
the SERVER line) to an unused TCP port of your choice.

d. Save your changes.
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After making these changes, your file should look similar to this
one:

# Date:10/09/2002
# SYNOPSYS INC. KEY CERTIFICATE
# Site Id: xxxx
#  XYZ Corporation
SERVER hostname 87654321 27000
DAEMON tmald  /usr/tcad/license/tmald
INCREMENT MD tmald 2002.2 18-nov-2002 10 4CA7B27176E3EAD691E3 \
VENDOR_STRING=MD SUPERSEDE ISSUED=9-oct-2002 ck=28 \
SN=RK:5447-0:431131:0
INCREMENT MDCA tmald 2002.2 18-nov-2002 1 1CC72201FA7990F2D5E2 \
VENDOR_STRING=MDCA SUPERSEDE ISSUED=9-oct-2002 ck=2 \
SN=RK:5447-0:431131:0
INCREMENT MDLT tmald 2002.2 18-nov-2002 1 DC0742C1FD0D57EECEF9 \
VENDOR_STRING=MDLT SUPERSEDE ISSUED=9-oct-2002 ck=84 \
SN=RK:5447-0:431131:0
#

4. Log on to the server node indicated by the SERVER line hostid
field of the license.dat file. (In the preceding example, the hostid
is 87654321.)

5. Log on to the server node indicated by the SERVER line of the
license.dat file. (In the preceding example, the hostid is
87654321.)

6. Start the TCAD license daemon.

a. If you are using the C shell, enter

% ./lmgrd -c <TCAD directory>/license/license.dat >& \
<TCADdirectory>/license/license.log &

b. If you are using the Bourne or Korn shell, enter

$ ./lmgrd -c <TCAD directory>/license/license.dat > \
<TCAD directory>/license/license.log 2>&1 &
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7. Check the license.log (debug logfile) to make sure the TCAD
tmald daemon has started correctly. If it hasn’t, contact your
system administrator for assistance, and see Table 29-2 on
page 29-5.

8. Create a script to start up the tmald daemon automatically each
time you start up the license server. See “Starting the License
Daemon Automatically” on page 29-13.

Setting the User Environment to Find the TCAD License

When you start a TCAD tool, the tool looks for a license in this order:

• The default location, <TCAD directory>/license/license.dat

• TCADLIC

• LM_LICENSE_FILE

where TCADLIC and LM_LICENSE_FILE are environment variables
that point to the license server. For example,

setenv LM_LICENSE_FILE /path/to/license.dat

Starting the License Daemon Automatically

If you want to start the TCAD license daemon every time the server
machine starts, your system administrator must modify the startup
files. Following are the procedures for the various platforms.

Note:
You must be logged on as root to run the following procedures.
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HP 9000/700 Series HP-UX

To make the TCAD license daemon start at startup,

1. Create a file named tmald in the /sbin/init.d directory and add the
following lines:

#
# TCAD Software
#
if [ ! -f /<TCAD directory>/license/lmgrd ]; then
   echo ’cannot startup TCAD Network License Software
daemon: no
 lmgrd found’
   exit
fi

case ”$1” in
’start’)
  /<TCAD directory>/license/lmgrd -c /<TCAD directory>/
license/license.dat\
    > /<TCAD directory>/license/license.log 2>&1 &
       ;;
’stop’)
  /<TCAD directory>/license/lmdown -q -c \
    /<TCAD directory>/license/license.dat
        ;;
esac

2. Link the script to the /sbin/rc3.d file so that the license daemon is
automatically stopped and started when the init state changes to
run level 3. Level 3 is multiuser with resources exported. Link the
script by entering the following commands:

ln -s /sbin/init.d/tmald /sbin/rc3.d/S17tmald
ln -s /sbin/init.d/tmald /sbin/rc3.d/K17tmald

IBM RS/6000 AIX

Modify the /etc/inittab file by adding the following line to the end of
the file:
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tmald:2:once:/<TCAD directory>/license/lmgrd -c \
     /<TCAD directory>/license/license.dat \

> /<TCAD directory>/license/license.log 2>&1 & # TCAD
Software

Sun Solaris 2

To make the TCAD license daemon start at startup,

1. Create a file named tmald in the /etc/init.d directory and add the
following lines:

#
# TCAD Software
#
if [ ! -f /<TCAD directory>/license/lmgrd ]; then
   echo ’cannot startup TCAD Network License Software
daemon: no
 lmgrd found’
   exit
fi

case ”$1” in
’start’)
  /<TCAD directory>/license/lmgrd -c /<TCAD directory>/
license/license.dat\
    > /<TCAD directory>/license/license.log 2>&1 &
       ;;
’stop’)
  /<TCAD directory>/license/lmdown -q -c \
    /<TCAD directory>/license/license.dat
        ;;
esac

2. Link the script to the /etc/rc3.d file so that the license daemon is
automatically stopped and started when the init state changes to
run level 3. Level 3 is multiuser with resources exported. Link the
script by entering the following commands:

ln -s /etc/init.d/tmald /etc/rc3.d/S17tmald
ln -s /etc/init.d/tmald /etc/rc3.d/K17tmald
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DEC Alpha OSF/1

To make the TCAD license daemon start at startup,

1. Create a file named tmald in the /sbin/init.d directory, containing
the following lines:

#
# TCAD Software
#
if [ ! -f /<TCAD directory>/license/lmgrd ]; then
   echo ’cannot startup TCAD Network License Software
daemon: no
 lmgrd found’
   exit
fi

case ”$1” in

’start’)
/<TCAD directory>/license/lmgrd -c /<TCAD directory>/

license/license.dat\
      > /<TCAD directory>/license/license.log 2>&1 &
       ;;
’stop’)
   /<TCAD directory>/license/lmdown -q -c \
      /<TCAD directory>/license/license.dat
       ;;
esac

2. Link the script to the /sbin/rc3.d file so that the license daemon is
automatically stopped and started when the init state changes to
run level 3. Level 3 is multiuser with resources exported. Link the
script with the following commands:

ln -s /sbin/init.d/tmald /sbin/rc3.d/S17tmald
ln -s /sbin/init.d/tmald /sbin/rc3.d/K17tmald
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Checking the Status of the License Daemon

You can check the status of the TCAD license daemon in either of
the following ways:

• Check the contents of the license.log license log file.

• Use the lmstat utility.

The license.log file logs information about the license manager and
the licenses that are checked out and in. An example of a license.log
file follows:

8/05 17:57:57 (lmgrd) FLEXlm - Copyright 1988, 1992, Highland
Software, Inc.
8/05 17:57:57 (lmgrd) FLEXlm (v2.40) started on mycomputer
(Sun) (8/5/93)
8/05 17:57:57 (lmgrd) License file: “/usr/myaccount/tcad/
license/license.dat“
8/05 17:57:57 (lmgrd) Started tmald
8/05 17:57:57 (tmald) Server started on mycomputer for: MD
8/05 17:57:57 (tmald)  MDCA            S4
8/05 17:59:11 (tmald) OUT: MD v1.100 by usera@computera(/
dev/ttyp6)
8/05 18:05:22 (tmald) IN: MD v1.100 by usera@computera(/dev/
ttyp6) (used: 0:00:06:11)

The status of the TCAD license daemon can also be checked by
running the lmstat utility. The format of lmstat is

<TCAD directory>/license/lmstat -c <TCAD directory>/
license/license.dat
[-a] [-S <daemon>] [-f <feature>] [-s <server>] [-t <value>]
[-A] [-l
 <regular expression>]
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where

For example, if your TCAD directory is /usr/tcad and you enter

/usr/tcad/license/lmstat -c /usr/tcad/license/license.dat -a

you get a message similar to the following one:

lmstat - Copyright (C) 1989, 1992 Highland Software, Inc.
Flexible License manager status on Wed 11/3/93 16:01

License server status:

mycomputer: license server UP (MASTER)

Vendor daemon status (on mycomputer):

tmald (v3.x): U
Feature usage info:

Users of MD:  (Total of 5 licenses available)

Users of MDCA: (Total of 2 licenses available)

Value Description

-a Displays everything.

-S <daemon> Lists all users of <daemon> feature.

-f <feature> Lists all users of <feature>.

-s <server> Displays the status of <server> node.

-t <value> Sets lmstat timeout to <value>.

-A Lists all active licenses.

-l <regular expression> Lists all users of license matching <regular
expression>.
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Users of S4:  (Total of 5 licenses available)

Rereading the License File

You can use the lmreread utility to reread the contents of the license
file, so that any changes made in the file are put into effect. The
format of lmreread is

<TCAD directory>/license/lmreread -c <TCAD directory>/
license/license.dat

Shutting Down the License Manager

You can use the lmdown utility to shut down the license daemon. The
format of lmdown is

<TCAD directory>/license/lmdown -c <TCAD directory>/
license/license.dat

Removing a User’s License

If your system crashes while a license is checked out, the license
might remain checked out. You can use the lmremove utility to
remove a single user’s license for a specified feature and return the
license to the pool of available licenses. The format of lmremove is

<TCAD directory>/license/lmremove -c <TCAD
directory>license
/license.dat <feature> <user> <host> [<display>]
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Adding New TCAD Products or Licenses

If you receive new TCAD products or new licenses, use the following
procedure to install the new authorization codes:

1. Change to the license directory in the TCAD directory by entering

% cd <TCAD directory>/license

2. Make a copy of your existing license.dat file by entering

% cp license.dat license.dat.org

3. Using a text editor, edit the license.dat file. Add the new
FEATURE lines provided by TCAD. Do not change the existing
SERVER or DAEMON lines.

4. Make the TCAD license daemon reread the new license file by
entering

% ./lmreread -c <TCAD directory>/license/license.dat

Customizing the options File

The options file allows you to customize the use of the licenses and
the behavior of some of the TCAD license software actions.

An options file consists of lines in the following format:

RESERVE <number of licenses> <feature> USER <userid>
RESERVE <number of licenses> <feature> HOST <hostname>
RESERVE <number of licenses> <feature> DISPLAY <display name>
RESERVE <number of licenses> <feature> GROUP <group name>
INCLUDE <feature> USER <userid>
INCLUDE <feature> HOST <hostname>
INCLUDE <feature> DISPLAY <display name>
INCLUDE <feature> GROUP <group name>
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EXCLUDE <feature> USER <userid>
EXCLUDE <feature> HOST <hostname>
EXCLUDE <feature> DISPLAY <display name>
EXCLUDE <feature> GROUP <group name>
GROUP <name> <list of userids>
TIMEOUT <feature> <timeout in seconds>
NOLOG IN
NOLOG OUT
NOLOG DENIED
NOLOG QUEUED
REPORTLOG <file>

RESERVE allows you to set aside a number of licenses of a given
program for a specific user, a specific CPU, a specific display, or a
specific group. A group is created by the GROUP line.

INCLUDE allows you to specify who is authorized to use a program.
With INCLUDE you can allow a specific user, a specific CPU, a
specific display, or a specific group to use a program. A group is
created by the GROUP line.

EXCLUDE allows you to specify who is not authorized to use a
program. With EXCLUDE you can deny access to a specific user, a
specific CPU, a specific display, or a specific group. A group is
created by the GROUP line.

GROUP defines a grouping of users for use with the RESERVE,
INCLUDE, or EXCLUDE control lines. Following the GROUP
keyword is a name that represents the group and a list of user IDs
separated by spaces.

TIMEOUT makes idle licenses return to the free pool so they can be
used by someone else.
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NOLOG lets you turn off the message reporting for IN, OUT,
DENIED, or QUEUED messages. This option is useful for reducing
the license log file size.

REPORTLOG allows you to specify a file for reporting activity. If the
file name starts with a plus sign (+) character, the old report log file
is opened for appending.

Note:
This file is useful only with third-party tools such as the
Globetrotter SamSuite/FLEXadmin license administration utility.
Synopsys does not support problems with the REPORTLOG
utility. For more information about REPORTLOG, go to
http://www.macrovision.com/solutions/esd/support/
samfaq.htm#Q2.

The following is an example of an option file:

GROUP tcad art joe bill
RESERVE 5 MD GROUP tcad
EXCLUDE MD USER sales
NOLOG IN
NOLOG OUT

The GROUP line defines a group named tcad that contains the user
IDs art, joe, and bill. The RESERVE line reserves 5 Medici licenses
for the group tcad. The EXCLUDE line does not allow the sales user
ID access to Medici. The NOLOG IN line turns off the message
reporting of licenses being checked back in. The NOLOG OUT line
turns off the message reporting of licenses being checked out.

To use an option file, add the full path to the option file on the
DAEMON line of the license.dat file. For example, if your option file
is the /usr/tcad/license/option.dat file, your DAEMON line looks
similar to the following one:
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DAEMON tmald /usr/tcad/license /usr/tcad/license/option.dat

Running TCAD Products

Table 29-4 lists the general format for most TCAD products. (For
product availability for this release, see “Media Availability and
Supported Platforms” on page 29-2.) If you install multiple versions
of a product, the executable name is whatever you chose during
installation. For most products, if you run them without specifying an
input file, you are in interactive mode.

Table 29-4 Formats for TCAD Products

Product Format Description

Aurora aurora <input filename> Runs Aurora with an input file.

Aurora auroragui Runs the Aurora GUI.

Davinci davinci <input filename> Runs Davinci (30,000 nodes) with an
input file.

Davinci dv30k <input filename> Runs Davinci (30,000 nodes) with an
input file.

Davinci dv60k <input filename> Runs Davinci (60,000 nodes) with an
input file.

Davinci dv100k <input filename> Runs Davinci (100,000 nodes) with an
input file.

Medici medici <input filename> Runs Medici (10,000 nodes) with an
input file.

Medici md3200 <input filename> Runs Medici (3,200 nodes) with an
input file.

Medici md10000 <input filename> Runs Medici (10,000 nodes) with an
input file.
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Using Graphics Devices

This section discusses how graphics devices are described to TCAD
products and how they are specified with parameters of program
statements.

Graphics Device Hierarchy

With TSUPREM-4, the graphics device used is determined as
follows:

• If a graphics device is specified in the input file with the DEVICE
parameter on the OPTION statement, TSUPREM-4 uses that
device.

Medici md20000 <input filename> Runs Medici (20,000 nodes) with an
input file.

Medici md60000 <input filename> Runs Medici (60,000 nodes) with an
input file.

Raphael raphael <Raphael program>
<input filename>

Runs Raphael with an input file.

Raphael dplot <input filename> Runs Dplot with an input file.

Taurus Layout layout
<input filename>

Runs Taurus Layout with an input file.

Taurus Visual tv Runs Taurus Visual.

Taurus
WorkBench

twb <input filename> Runs Taurus WorkBench with an
input file.

TSUPREM-4 tsuprem4 <input filename> Runs TSUPREM-4 with an input file.

Table 29-4 Formats for TCAD Products (Continued)

Product Format Description
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• Otherwise, if the DEFPDEV environment variable is defined,
TSUPREM-4 uses its value as the graphics device.

• Otherwise, if the TERM environment variable is defined,
TSUPREM-4 uses its value as the graphics device.

• Otherwise, TSUPREM-4 uses the default device specified in the
s4pcap file, which is initially set to ps for Postscript. The s4pcap
file contains a description of each device known to the program.
You can modify the file to make the default device refer to any
available real plotting device. The default device specified in the
s4pcap file is used if neither DEFPDEV nor TERM is defined.

With the other simulators, the graphics device used is determined as
follows:

• If a graphics device is specified in the input file with the DEVICE
parameter on the PLOT statement, that device is used.

• Otherwise, if the DEFPDEV environment variable is defined, its
value is used as the graphics device.

• Otherwise, the default graphics device is used. The default
graphics device is defined by the first line in the <pr>pdev file that
contains an asterisk (*) as the first nonblank character. The
<pr>pdev file is located in your TCAD directory in
<program>_<version>/library.

Specifying a Graphics Device

With TSUPREM-4, you can specify the graphics device in the input
file with the DEVICE parameter on the OPTION statement. For
example, the following statement sets the graphics device to X:

OPTION DEVICE=X
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If you do not specify a graphics device in the input file, the DEFPDEV
environment variable is used if it is set. You can set DEFPDEV to
specify the graphics device by entering the following command:

% setenv DEFPDEV <graphics device>

If you are using the Bourne or Korn shell, you can specify a graphics
device using DEFPDEV by entering the following commands:

$ DEFPDEV=<graphics device>
export DEFPDEV

If you are using the C shell, you can set DEFPDEV so that the X
graphics device is used by entering the following command:

% setenv DEFPDEV x

Note:
The graphics device must be entered in lowercase letters.

By setting the value of the DEFPDEV environment variable, you can
set the graphics device to any device you want to use without
disrupting work in progress by other TCAD software users.

With TSUPREM-4, if neither OPTION nor DEFPDEV is specified,
TSUPREM-4 checks the TERM environment variable. TSUPREM-4
looks for the graphics device specified by TERM in the s4pcap file. If
the graphics device is not found, and neither the OPTION statement
nor DEFPDEV is specified, TSUPREM-4 prints the following
messages:

** Plot device vt100 not found in s4pcap file.

** Plotting to default device in s4pcap file.
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where

vt100 is the name of the device to which TERM is set.

With TSUPREM-4, if OPTION is not used and neither DEFPDEV nor
TERM is set, TSUPREM-4 uses the default graphics device set in
the s4pcap file. By default, the graphics device is set to ps in the
s4pcap file.

With most other simulators, you can specify the graphics device in
the input file with the DEVICE parameter on the PLOT statement. For
example, the following statement sets the graphics device to X:

PLOT.2D TITLE=”EXAMPLE” DEVICE=X

With the other TCAD simulators, if the PLOT statement does not
specify a graphics device and DEFPDEV is not set, the simulator
uses the default graphics device. The default graphics device is
defined by the first line in the <pr>pdev file that contains an asterisk
(*) as the first nonblank character. (The <pr>pdev file is located in
your TCAD directory in <program>_<version>/library.)

For example, if you want to change the default graphics device from
Sun to X, edit the <pr>pdev file and move the asterisk (*) from the
Sun entry to the X entry.

Before modification:

*SUN 29 20.32 15.24 33.0 33.0 -1 F F FTFF 9999
I/SUN 29 20.32 15.24 33.0 33.0 -1 F F FTFT 9999
X 30 20.32 15.24 500.0 500.0 -1 F F FTFF 9999

After modification:
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SUN 29 20.32 15.24 33.0 33.0 -1 F F FTFF 9999
I/SUN 29 20.32 15.24 33.0 33.0 -1 F F FTFT 9999
*X 30 20.32 15.24 500.0 500.0 -1 F F FTFF 9999

For further information on the <pr>pdev file and possible graphics
devices, see the manual for the TCAD product you are installing.

Sun, X, and tmaplot

Both Sun and X drivers use the tmaplot graphics utility to generate
graphics by piping graphics output through the tmaplotx executable
program. The tmaplot utility automatically remembers up to 200 plots
and allows you to scroll through them.

Use the following means to control the display:

• Right mouse button:scroll backward

• Left mouse button:scroll forward

• Control-C:Kill tmaplot display

To use X graphics, you must set the DISPLAY environment variable
to your display machine. Usually, DISPLAY is set to the name of your
computer followed by :0.0. For example, if the name of your machine
is mymachine, enter the following command to set DISPLAY:

% setenv DISPLAY mymachine:0.0

Note:
To Sun users—You must also set the LD_LIBRARY_PATH
environment variable to your OpenWindows library directory. For
example,

% setenv LD_LIBRARY_PATH /usr/openwin/lib
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Using the TCAD Network License System and Software

The TCAD authorization system is a networkwide license system
that uses the popular Globetrotter Software package, FLEXlm. This
program offers choices of licensing options.

• If you have a floating-type license, you can run the program on
any CPU on a computer network.

• If you prefer the CPU-based system of the old authorization
system, use a node-locked license.

Instead of each program having its own separate authorization file,
the new system uses a single license file for all programs.

With the TCAD Network License System, a server on your network
runs the TCAD license daemon, unless you have an unlimited
node-locked license. When you run a TCAD program, it requests a
license from the TCAD license daemon. If a license is available, the
program runs as normal. If no licenses are available, you are given
the option of waiting for the next available license, listing the current
users of the program, or exiting the program.

No daemon is required for an unlimited node-locked license. When
you run a TCAD program, it checks the license file. If the CPU you
are running on is authorized, the program runs as normal. If the CPU
is not authorized, the program exits with an authorization failure.

Handling an Authorization Failure

For TCAD Network License Software authorized products, an
authorization failure can occur if the TCAD Network License
Software is installed incorrectly. An authorization failure produces a
message similar to this one:
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Error during attempt to get PR Version #.# license.
Error was: no such feature exists

If you have problems, see “Authorization Troubleshooting” on
page 29-31. If your license has expired or you require additional
licenses, contact TCAD for assistance.

You must give the correct machine ID to TCAD so TCAD can give
you the proper codes. For node-locked licenses, TCAD requires this
ID number for each CPU on which the TCAD product is to be
executed. For floating licenses, TCAD requires this ID number for
each CPU that acts as a license server. If TCAD Network Licensing
Software is installed, you can run the lmhostid command to get the
CPU’s ID.

The command you use to get your machine ID and the returned
value is platform dependent. Use Table 29-5 to determine the
appropriate command for your platform.

Table 29-5 Platforms and Commands

Platform Command Returned value

DEC Alpha /usr/ucb/pfstat
or
/usr/sbin/arp<hostname>

The Ethernet address

HP-UX echo ’uname -i’ 16o p | dc The 8-digit hex ID

IBM RS/60001

1. Products that support the RS/6000 platform will be available by EST at a later date. For more
information, contact your local applications consultant.

uname -m The 12-digit hex ID

Linux /sbin/ifconfig eth0 The 12-digit hex ID

Sun Solaris hostid The 8-digit hex ID
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If you have problems with these commands, you can download the
lmutil executable file for your platform from http://
www.globetrotter.com/flexlm/lmgrd.shtml and run the lmutil lmhostid
command.

Note:
To DEC Alpha users—The /usr/sbin/arp command should be run
on another machine. For example, if the names of your machines
are mach1 and mach2 and you want to install the TCAD product
on mach1, run the /usr/sbin/arp mach1 command on the mach2
machine. If you have problems determining the Ethernet address
of your DEC Alpha machine, ask your system administrator for
assistance.

Troubleshooting

This section describes some of the common error messages and
what to do if you receive them.

Authorization Troubleshooting

Error Message:

Error during attempt to get XX Version Y.Y license
Error was: no such feature exists

Explanation:

Either the license file does not have the authorization codes for the
program, or the program is looking at the wrong license file.

• Check to be sure the license.dat file in the <TCAD directory>/
license directory contains authorization codes for the program.
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• If you just added the authorization codes for the program and
your license is not an unlimited node-locked license, make sure
the daemon rereads the license file by running the lmreread
command. For details on using lmreread, see Table 29-2 on
page 29-5.

• Check to determine whether the LM_LICENSE_FILE
environment variable is set by entering the following command:

% env

This command prints a list of the environment variables you set. If
you have the LM_LICENSE_FILE environment variable set, the
program might be looking at the license files specified by
LM_LICENSE_FILE rather than the license file specified by
TCADLIC.

If you have LM_LICENSE_FILE set and you are using the
C shell, you can add the TCAD license file to the environment
variable by entering the following command:

setenv LM_LICENSE_FILE ${LM_LICENSE_FILE}:\
  <TCAD directory>/license/license.dat

Add this command to your .cshrc or .login file so that the environment
variable is set correctly every time you log on.

If you are using the Bourne or Korn shell, you can add the TCAD
license file to the environment variable by entering the following
commands:

LM_LICENSE_FILE=$LM_LICENSE_FILE:<TCAD directory>/ \
 license/license.dat
export LM_LICENSE_FILE
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Add this command to your .profile file so that the environment
variable is set correctly every time you log on.

Error Message:

Error during attempt to get XX Version Y.Y license
Error was: cannot find license file

Explanation:

The license file cannot be found.

• Check to be sure the license.dat file exists in the <TCAD
directory>/license directory.

• Check to be sure the LM_LICENSE_FILE environment variable
is set. Refer to the previous error message for details on checking
and setting the environment variable.

Error Message:

Error during attempt to get XX Version Y.Y license
Error was: cannot read license file

Explanation:

The license file cannot be read.

• Check to be sure the users have read permission on the
license.dat file.

• Check to be sure the license.dat file that exists in the <TCAD
directory>/license directory is valid.

Error Message:

Error during attempt to get XX Version Y.Y license
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Error was: wrong host for program XX

Explanation:

Either the license file contains node-locked licenses and the CPU is
not authorized or the program is fetching the CPU ID incorrectly.

• Check to be sure the CPU you are running the program on is
authorized to run it.

• If you are on an HP machine, check the file permissions on the
/dev/lan0 file. If the file permissions on this file are not set to
read/write by owner, group, and world, the CPU ID could be
obtained incorrectly.

Error Message:

Error during attempt to get XX Version Y.Y license
Error was: Checkout of program XX failed
feature has expired

Explanation:

Either the license for the program has expired or the date is set
incorrectly.

• Check the date on the system.

Error Message:

Error during attempt to get XX Version Y.Y license
Error was: Checkout of program XX failed
cannot connect to license server
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Explanation:

The license daemon is no longer running on the server.

• Log on to the server and restart the TCAD license daemon.

Error Message (in license log file):

3/18 15:46:17 (lmgrd) FLEXlm - Copyright 1988, 1992, Highland
Software, Inc.
3/18 15:46:17 (lmgrd) Retrying socket bind (address in use;
port 7606)

Explanation:

The TCP port specified in the license.dat file is in use.

• Change the TCP port number in the license.dat file to an
available port.

General Troubleshooting

Error Message:

Xlib:  connection to "machine:0.0" refused by server
Xlib:  Client is not authorized to connect to Server
Bad return from XOpenDisplay

Explanation:

The program does not have permission to open a window on the
display.

• Check to be sure the DISPLAY environment variable is set
correctly.
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• If the DISPLAY environment variable is set correctly on the
console of the display, enter the following command:

% xhost +

Error Message:

tmafork: command not found

Explanation:

The tmafork TCAD utility cannot be found.

• Check to be sure the TCAD bin directory is in the search path.

• Check to be sure the TCAD utilities are installed correctly and
that tmafork is linked to the TCAD bin directory.

Error Message:

*** Open Pipe = signal 13 code 0

Explanation:

The TCADPLOT process is terminating abnormally, leaving the
TCAD program piping data to a broken pipe.

• Check to be sure TCADPLOT works correctly outside the TCAD
program by entering the following command:

% tmaplot x test
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• If TCADPLOT works correctly outside the TCAD program, the
error is most likely caused by insufficient system resources to
start the TCADPLOT process. Check your system resources
when running the TCAD program to be sure there are enough
resources to run the TCADPLOT process.

Error Message:

window: Base frame not passed parent window in environment
Cannot create base frame. Process aborted.

Explanation:

You are attempting to run a SunView application when you are not
running in the SunView window environment. This error can occur
during STUDIO if your path is not set correctly.

• If you are running OpenWindows, be sure the OpenWindows bin
directory precedes the /bin and /usr/bin directories.
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TCAD Utilities

The TCAD utilities are a set of programs designed to help you use
TCAD products more effectively. TCAD utilities are installed
automatically as part of a TCAD product installation.

TCAD utility Directory

The utility directory for all new releases of TCAD products (after June
1991) is product independent. The utility directory contains a file
named V#.# (where # is a number). V#.# is the version number of the
utility in that directory.

Table 29-6 lists the utilities that TCAD provides.

Table 29-6 TCAD Utilities

Utility Description

tmaplot Generates Sun (SunView) and X graphics. For
products released after June 1991, you must use
tmaplot if you use Sun or X graphics.

tmafork Allows systems that do not have a vfork system
call to run a TCAD product without temporarily
doubling the virtual memory required.

replot Allows you to re-create TCAD graphical output
without rerunning a simulation.

rfbtoa Takes a TCAD binary output file, such as a
structure file, and converts it to ASCII format.

tfatob Takes a TCAD formatted (ASCII) file and
converts it to binary format.
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The tfatoa and tfbtob utilities are useful if you have TCAD products
on multiple machine types. A binary file can be transferred between
machines by converting it to ASCII on one machine and then
transferring it to the second machine. Then it can be converted back
to binary on the second machine.

Following is the directory structure of the utility directory, as it exists
in a standard installed TCAD directory tree. The directories are
shown with a trailing slash.

<TCAD directory>/bin/<TCAD product>/utility/
V#.#
install_utility

replot/
replot
replotx
rppdev
rperr0
tfatob/
tfatob
tfatovx
tfbtoa
tfbtoax
tferr0
tmafork/
tmafork
tmaplot/
tmaplot
tmaplotx
tfbtoa
tfbtoax
tferr0

Note:
The TCAD utilities do not require licenses. You can use them on
any machine under the direct control of your organization.
However, you are not allowed to copy or distribute the TCAD
utilities elsewhere.
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Executing the TCAD Utilities

To execute the TCAD utilities, you must include the tcad/bin directory
in your search paths, as described in “Setting Up Your Search Path”
on page 29-8.

If you install updates to the TCAD utilities in the future, the
installation script creates links from the new version of the TCAD
utilities to the tcad/bin directory. Therefore once the search path has
been modified to include tcad/bin, it is already set up for updates.
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additional requirements for HP-UX 1-3
patches 1-2
supported 1-2

P
PathMill

installing 13-2
platform keyword 1-6
product ID 1-6
setting up for new user 13-2
verifying installation 13-3

platforms
64-bit 1-4
installing additional 1-5
installing multiple 1-4
IN-3



PLI table file, modifying 3-15
Power Compiler VPower, installing 3-10
PowerArc

installing 14-2
platform keyword 1-6
product ID 1-6
setting up for new user 14-2
verifying installation 14-3

PowerMill
installing 15-2
platform keyword 1-6
product ID 1-6
setting up for new user 15-2
verifying installation 15-3

prerequisites for installing products
creating root directory 1-18
setting environment variable 1-19

PrimePower
installing 16-2

overlay 16-3
stand-alone 16-2

platform keyword 1-6
product ID 1-6
setting up for new user 16-4
verifying installation 16-5

PrimeTime
installing 17-2
media installation script 2-12
platform keyword 1-6
product ID 1-6
setting up for new user 17-3
verifying installation 17-5

product files
downloading

by FTP 2-3
from the Web 2-4

installing
by electronic software transfer 2-5
from CD 2-6

types of packaging 2-2
untarring 2-5
untarring and uncompressing 2-5

R
RailMill

installing 18-2
platform keyword 1-7
product ID 1-7
setting up for new user 18-2
verifying installation 18-3

root directory, creating 1-18

S
Scirocco (see VHDL Simulation (Scirocco))
SCL (see Synopsys Common Licensing)
script

Synopsys media installation
for PrimeTime 2-12
for synthesis tools 2-9

semaphores, IPC 7-8
setprivgrp 1-3
setting defaults

CoCentric Fixed-Point Designer 6-3
CoCentric System Studio 7-3
synthesis tools 3-6

site identification number, finding 1-18
software

downloading
by FTP 2-3
from the Web 2-4

installing
by electronic software transfer 2-5
from CD 2-6

SOLD 24-2
contents of CD-ROM 24-7
installation

CD 24-9
configuring for new user 24-10
electronic software transfer 24-8
options 24-7
partial 24-9
verifying 24-10

software for reading and searching 24-3
IN-4



Star-RCXT
documentation 28-5
installing 28-2
media 28-2
setting up for each user 28-4
supported platforms 28-2
verifying installation 28-5

swap space 1-12, 25-4
Synopsys Common Licensing 1-16

acquiring a license 1-16
acquiring documentation 1-18
installing 1-17
obtaining keys 1-16

SYNOPSYS environment variable 1-19
Synopsys Integrator for Falcon Framework 3-9
Synopsys Online Documentation (see SOLD)
Synopsys platform keywords 1-2
Synopsys power directory 3-11
Synopsys Qualified Runtime System
Configuration 1-2
Synopsys root directory, creating 1-18
.synopsys_dc.setup 25-5
SYNOPSYS_SIM environment variable 23-2
synthesis tools

configuring 3-4
installing 3-3
list 3-2
platform keyword 1-7
product ID 1-7
setting up for new users 3-4
verifying installation 3-18

system requirements
disk space 1-8
FPGA Compiler II on Windows 11-2
memory 1-10

SystemC Compiler, setup 3-7
SystemC, installing 6-2
systemwide defaults

CoCentric Fixed-Point Designer 6-3
CoCentric System Studio 7-3
synthesis tools 3-6

T
tar files, types of 2-2
TCAD

adding new license 29-20
disk requirements 29-5
downloading software 29-3
establishing directory tree 29-5
graphics

devices 29-24
specifying devices 29-25
Sun, X, tmaplot 29-28

license daemon, checking status 29-17
license file

customizing 29-20
lmdown utility 29-19
lmreread utility 29-19

obtaining SolvNet account 29-3
platforms 29-30
product format and description 29-23
products, installing 29-2
requesting CD media 29-3
running installation script 29-6
search path

modifying 29-9
setting up 29-8

troubleshooting 29-31
authorization 29-31
general 29-35

utilities 29-38
TCAD utilities 29-38
TetraMAX

installing
overlay 19-4
stand-alone 19-2

license key requirements 19-2
platform keyword 1-7
product ID 1-7
verifying installation 19-7

TimeMill
installing 20-2
platform keyword 1-7
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product ID 1-7
setting up for new user 20-2
verifying installation 20-3

tools
synthesis 3-2

troubleshooting
CoCentric System Studio 7-7
memory 25-2
X Windows System 25-5

V
VCS

installing 21-2
platform keyword 1-7
product ID 1-7
setting up for new user 21-2
support 21-4
verifying installation 21-3

VCS simulator 3-15
VCSi, installing 21-2
Vera

product ID 1-7
documentation, obtaining 22-5
downloading and installing 22-2
environment variables, setting 22-3

license 22-4
VERA_HOME 22-3

platform keyword 1-7
support

license 22-5
technical 22-5

verifying installation
AMPS 4-3
Arcadia 5-3
budget_shell 17-5
CoCentric Fixed-Point Designer

6-4
CoCentric System Studio 7-6
Floorplan Compiler 8-3
Formality 9-3

NanoSim 12-3
PathMill 13-3
PowerArc 14-3
PowerMill 15-3
PrimePower 16-5
RailMill 18-3
stamp_compiler 17-5
synthesis tools 3-18
TetraMAX 19-7
TimeMill 20-3
VCS 21-3

Verilog-XL simulator 3-10
veriuser.c file, modifying 3-11
VHDL simulation 7-6
VHDL Simulation (Scirocco)

creating root directory 23-2
installing 23-3
platform keyword 1-7
product ID 1-7
setting environment variable 23-2
setting up for each user 23-4
verifying installation 23-4

VPOWER
linking to Verilog-XL simulator 3-10
makefile 3-14
vconfig 3-13

VPOWER, Power Compiler
installing 3-10

X
X Window System

available colors 3-6
troubleshooting 25-5

xinitrc 25-6
xterm 25-5
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